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ABSTRACT
TO 5300: Integrated Construction Zone Traffic Management
Michael Zhang, Wei Shen, Yu Nie' and Jingtao Ma 2
Department of Civil & Environmental Engineering
University of California Davis
Davis, California 95616

Nonrecurrent traffic congestion caused by construction work constitutes a large proportion
of the traffic congestion on highways. In TO 5300, we developed a comprehensive work zone
traffic impact assessment procedure using a series of state-of-the-art dynamic network analysis
tools as building blocks. This procedure is then implemented into a work zone traffic impact
assessment software package called NetZone. This software package is capable of estimating
time-dependent travel demand based on link counts, estimating demand diversion in response
to work zone delay and various traffic management measures, showing traffic congestion level
in the network over time, and providing network wide traffic performance measures with and
without traffic congestion mitigation measures. The traffic performance measures provided in
NetZone include average and longest delays, average and longest queue lengths, as well as the
total delay in the network, before and during construction. Moreover, a friendly graphical user
interface makes NetZone easy to learn and use, and a preliminary case study shows that one can
use it to study a reasonably large network in a fraction of time that a micro-simulation package
takes for the same network.

The developed methods and tools can help better plan and operate construction activities
on highways, and more effectively manage traffic to reduce travel delays, both are consistent
with Caltrans’s goals of increasing productivity and safety.

Keywords: Rehabilitation, construction work zone, traffic impact, work zone traffic man-

agement, NetZone, traffic congestion, peak spreading, traffic diversion, traffic simulation.

"Now with Department of Civil and Environmental Engineering, Northwestern University, Evanston, Illinois.
2Now with PTV America, Vashon, Washington.






Executive Summary

The central goal of this project is to develop a systematic traffic analysis procedure for construc-
tion work zones that can work with construction analysis tools such as CAL4PRS to optimize
both the construction layout/schedule and traffic management strategies to reduce traffic con-
gestion and enhance work zone traffic safety. The main accomplishments and key findings of

this project include

e Conducted a systemamtic review of current CWZ traffic analysis tools. We
identified four types of tools often used in work zone traffic analysis: queue-based tools
(e.g., Demand/Capacity and QuickZone), transportation planning models (e.g., TP+,
EMME/2), macroscopic freeway simulation models (e.g., FREQ), and microscopic traffic
simulation models (e.g., Paramics). These tools vary widely in terms of key assumptions,
input data, outputs produced and computational performances. The first type of tools
are simple and easy to use, require minimal inputs, and can be carried out very quickly.
However, they either do not model peak spreading and/or route diversions, and how traf-
fic management measures such as ramp metering and real-time traveler information affect
system performance at all, or model them in a superficial manner. Such tools can be
used as a sketch planning tool to get the first cut of the magnitude of traffic conges-
tion caused by a CWZ. The second type, transportation planning tools, can model large
networks and the redistribution of traffic in a network, but these tools were designed to
evaluate the long-term effect of certain changes to a network, where traffic can take time
to settle-down to an “equilibrium” (or steady-state condition), which is not the case for
CWZ traffic. Naturally, this type of tools are not capable of modeling peak spreading and
the growth and decay of queues in front of the CWZ and at other places in the network.
The third type, macroscopic traffic simulation, holds promise for being an effective CWZ
traffic analysis approach, but the widely used tools in this category, like FREQ, are not
capable of modeling a general road network. Finally, the microscopic simulation tools are
powerful general purpose traffic analysis tools, and offer a wide range of features, including
detailed representation of the network, a variety of traffic management measures, dynamic
traffic modeling, and usually a powerful graphical user interface. However, these power-
ful features also come with a price: microscopic simulation tools require intensive inputs,
elaborative network coding, and a steep learning curve. They are also notoriously difficult

to calibrate, particularly when the network in consideration becomes large.
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iii
Our review tells us that there still lacks an effective CWZ traffic analysis procedure that
possess the following characteristics: 1) model different geographic scopes e.g., isolated
work zones, corridor, multiple CWZs in a complicated network; 2) model diverse traffic
management measures e.g., change in signal timing, traveler information system, speed
limit, lane re-stripping, etc., 3) model travelers’ responses to capacity reduction in CWZ
and to management measures e.g., no response, divert to an alternative route, change
departure time, cancel the trips, switch to other modes, etc.; 4) produce detailed per-
formance measures e.g., aggregate indices (e.g., total travel time, delay, maximal queue)
and disaggregate indices (e.g., delay and queuing on specific links); and 5) be easy to use,
easy to collect input data, calibrate parameters, and set up the model, provide reasonable

results with acceptable computational overhead.

Based on our review and our own experience with different CWZ traffic analysis tools,
we took the macroscopic simulation approach to develop the tool that meets the above

requirements.

Investigated travel demand shifts. We studied the demand patterns before and during
construction for two rehabilitation projects: the I-710 Long Beach project and the I-15
Devore project. Our study reveals that 1) demand diversion rate seems to be highly related
to network topology, i.e., the availability of detour routes, and the dominant travel purpose
through the CWZ area; 2) the time of construction (weekend or weekday), use of traveler
information system, previous traffic condition, and capacity reduction proportion may
affect diversion, but the effect is not pronounced in these two projects; and 3) compared
to demand reduction, the peak spreading effect is relatively small (I-15 project, slight

shifts; I-710 project, trivial). However, more data are needed to draw firm conclusions.

Developed a general purpose CWZ traffic analysis software NetZone. We pro-
posed a systematic work zone traffic analysis procedure for quickly assessing network-wide
traffic impact of a given construction plan. This procedure includes demand preparation,
dynamic traffic assignment, macroscopic traffic simulation, and scenario analysis. We im-
plemented this procedure into a software package called NetZone, which is a powerful,
versatile and user-friendly analysis tool for work zone projects that takes into account
1) demand changes, 2) route diversions, 3) ramp metering, 4)arterial traffic operations,
and 5)traveler information. It provides detailed statistics on delays and queues on specific
links and routes as well as the entire network. Because it is macroscopic, it consumes
much less computational and human resources to calibrate and apply than microscopic
simulations, and because it is dynamic, it captures peak spreading and queuing. With

suitable modifications, it can also be used as a general purpose corridor study tool.

Evaluated NetZone with the SR-41 case study. We carried out a case study on a
stretch of SR-41 to evaluate NetZone. This stretch of the SR-41 Fresno corridor network
contains 1365 nodes, 2090 links, 174 origins and 168 destinations, with 7100 OD pairs, 83






iv
signalized intersections on the arterial roads and 16 ramp meters. It is a network that took
months to build and calibrate in Paramics. With NetZone, it is coded and calibrated in
weeks, and four construction/traffic management scenarios were evaluated and the initial

results were encouraging.

The developed methods and tools can help better plan and operate construction activities
on highways, and more effectively manage traffic to reduce travel delays, both are consistent

with Caltrans’s goals of increasing productivity and safety.
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Chapter 1

Introduction

1.1 Background

Timely maintenance, rehabilitation or reconstruction of aging highway sections is vital to main-
taining a safe, reliable and efficient highway network. Many sections of the interstate freeway
system, which were constructed from as early as the 1950s with a typical pavement design life
of 20 years, have well passed their design life. In California, the highway system as a whole
has around 16,662.16 miles ', 90 percent of which were built between 1955 and 1970 with the
typical 20-year design life. A large portion of these highways has been exposed to heavier traffic
volumes and loads than it was originally designed for. Consequently, the transportation net-
work has deteriorated significantly. The deterioration of the highway pavements has started to
adversely affect road user safety, ride quality, vehicle operating costs, and the cost of highway
maintenance. Most of these highways need major rehabilitation or reconstruction in the coming
decade in order to maintain their structural integrity and provide a safe and efficient traveling
environment for the millions of motorists who travel on them.

The closure of any lane of a highway facility for maintenance work causes a substantial
reduction in its operating capacity. Sizable capacity loss can result in a road network if many such
activities are carried out at the same time. For example, more than 60 million vehicles per hour
per day of capacity were estimated to be lost due to work zones over a two week period during
the peak summer roadwork season throughout the country (Wunderlich & Hardesty 2002). Such
significant reductions in road capacity could result in considerable increases in traffic delay, crash
risks, vehicle emissions, fuel consumption and other external costs in and around work zone areas
and also on alternative routes.

It is expected that more maintenance, rehabilitation and reconstruction activities will take
place on interstate and state highways in the coming years. The Federal Highway Administration
(FHWA) has estimated that, there are 6500 to 7200 work zones in the National Highway System
during the peak roadwork season and 2000 to 3000 during the off-peak season (Wunderlich &
Hardesty 2002). In California, Caltrans launched the long-life pavement rehabilitation strategies

! According to www.cahighways.org/stats



CHAPTER 1. INTRODUCTION 2
(LLPRS) program in 1998 to rebuild approximately 2,800 lane-km of the state highway network

over 10 years. Most of the candidate sites are in heavily traveled urban corridors in South-
ern California, the San Francisco Bay area and and the Sacramento area. Without a proper
construction and traffic mitigation plan, construction activities in these heavily traveled urban
corridors could make the already critical conditions, leading to nightmarish traffic conditions
and spurred a stream of research and experiments on work zone management—the design of
construction schedules and traffic management plans—to reduce traffic delay and environmental
impact, and improve safety and throughput.

Thanks to the developments in information and I'TS technologies, a variety of means and
tools are now available for work zone traffic management. These include web-based pre-trip
traveler information systems, highway advisory radio, variable message signs, lane re-stripping,
advanced traffic detection, and integrated traffic control, to name just a few. While some of the
traffic management measures aim at increasing work zone and/or corridor traffic throughput, the
majority of them encourages diversions of traffic to alternative modes, departure times and/or
routes through providing travelers with both real-time and historical traffic information. The
outcome of the latter group of measures depends on the complex interactions among traveler
behavior, information quality, and the performance of the highway network, and is not well
studied. As a result, no firm conclusions were drawn with regards to their benefits (Fontaine
2003).

To design construction and traffic management plans for a work zone project at the plan-
ning stage, traffic engineers usually need to rely on work zone traffic impact analysis tools.
Several scenarios combing different work zone construction schedules and traffic management
plans may be evaluated with the appropriate modeling tool. The traffic impact of all the scenar-
ios, such as the total traffic delay, the maximal delay, the maximal queue length, are compared
and the best setting for implementation can be selected.

Unfortunately, such a work zone traffic impact analysis tool capable of facilitating con-
struction and traffic management decision making, is far from well developed. This is partly due
to the limited knowledge in travelers’ response to a work zone activity and mitigation measures,

and lack of an efficient method to quantify the redistributed traffic flow pattern in the network.

1.2 Objective, Scope and Tasks

In view of the importance of work zone traffic impact analysis and the unavailability of an
effective analysis tool, this project aims at integrating a series of state-of-the-art traffic analysis
methodologies into an easy-to-use software package for work zone traffic impact analysis. The
tool developed is expected to help traffic engineers to accurately estimate and compare the
work zone traffic impact under different construction and management scenarios. The methods
developed in this research can help to better plan maintenance, rehabilitation and construction
activities on highways, and more effectively manage traffic to reduce traffic congestion. The

deliverables contribute to Caltrans’ goals of increasing safety and productivity of its highway
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network, increasing productivity and cost reduction of pavement maintenance, rehabilitation
and reconstruction program.

The specific tasks of this project include

e Review the current practices in work zone traffic study in California and elsewhere on
several aspects, including methods to quantify work zone capacities, models to represent
demand diversion under various work zone conditions, and methods to estimate traffic
delays in work zones. Special attentions are paid to the data needs, reliability, ease of
use, user satisfaction, and limitations in assumptions of different models and approaches.
Based on the comprehensive review, we will identify the key elements of the best possible
work zone traffic study practice and the gaps between the current practices and the best

possible one.

e Develop a hierarchical procedure for quickly assessing the network wide impact of a par-
ticular construction and traffic management plan. For each step of the procedure, develop
or identify from the existing literature the required methodologies. In particular, to well
capture the travel demand diversion mechanism, a comprehensive data analysis of existing
work zone projects in California will be performed. Models to characterize travelers’ be-
havioral response to various work zone conditions and traffic management strategies will

be derived to predict the demand shifts to alternative routes, modes, and departure times.

e Implement each element in the proposed work zone traffic analysis framework using objected-
oriented programming (OOP) techniques. Two existing C++ class libraries developed at
UC Davis through several years of research effort, i.e., TNM which contains well-defined
network objects, and MAT which provides supports for programming both general and
network-specific optimization problems, are served as a starting point of implementation.
A graphical user interface(GUI) will also be designed to wrap up all the implemented

algorithms.

e Test the developed work zone traffic analysis software package using both hypothetical and
real network data. Quantify the accuracy and reliability of the procedure and the tool.

Discussions on the future research will also be presented.

This report is organized into six chapters. Chapter 2 reviews the work zone traffic analysis
related literatures, including work zone capacity definition, travel demand diversion and traffic
delay evaluation. Chapter 3 focuses on the travel demand diversion. Observations from two
California work zone projects will be reported and models to characterize travel demand diver-
sion will be constructed. Chapter 4 proposes a hierarchical work zone traffic impact analysis
procedure. The details of each step in the procedure will be discussed. Chapter 5 presents the
implementation details of the work zone traffic impact analysis tool - NetZone, and Chapter 6
reports numerical experiments. Finally, Chapter 7 provides conclusions and recommendations
for further research. The user manual for NetZone, the work zone traffic impact analysis software

package, will be provided in the Appendix of the report.



Chapter 2

Literature Review

In this chapter, we first review existing work zone traffic impact assessment methods and tools,
from which critical deficiencies of these methods and tools are identified. We then focus on
two critical elements in modeling work zone traffic, i.e., the characterization of work zone flow
capacity and the determination of travel demand diversion in the presence of work zones in a
road network. Relevant research on these two topics is discussed. Finally, based on the review
of the state-of-the-art and state-of-the-practice in work zone traffic management, we outline the
essential features of an effective work zone traffic impact assessment tool, which will be used as

a guide to develop next generation work zone traffic impact assessment tools.

2.1 Work Zone Traffic Impact Assessment Methods and Tools

Existing work zone traffic impact assessment methods and tools that have been applied to
actual highway maintenance, rehabilitation and construction projects can be classified into the

following five categories:

e Demand/capacity queuing analysis (e.g., Highway Capacity Software)

QuickZone

Transportation planning models (e.g., EMME/2)

Macroscopic freeway simulation models (e.g., FREQ)
e Microscopic traffic simulation models (e.g., Paramics)

Most of them, with the exception of QuickZone (Mitretek 2001), are all general purpose
transportation modeling tools. These methods vary widely in terms of key assumptions, input
data, outputs and computational performances. We now provide an overview of these models,

identify their strengths, weaknesses and scenarios under which they are most suitable.
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2.1.1 Demand/capacity queuing analysis

The demand/capacity (D/C) analysis method basically follows the guidelines provided by the
Highway Capacity Manual(HCM) 2000. It is essentially a deterministic queuing analysis pro-
cedure where the arrival and departure curves to and from a bottleneck (here the work zone)
are constructed to obtain work zone induced delay and queue length information. The Highway
Capacity Software (HCS) (by McTrans), written to accompany HCM 2000, is a useful tool for
users to estimate the delay and level of service associated with the change in geometric charac-
teristics of the highway (including lane closure due to work activities). The calculation methods
in HCM 2000 have been developed over more than 30 years, and validated with field data, and
therefore are widely recognized and adopted by transportation professionals.

In D/C analysis, the traffic demand is estimated from historical traffic counts obtained
at the same site before the commencement of maintenance, rehabilitation or construction work.
The capacity is modeled as the number of lanes that are still open to traffic, taking into account
the changes in layout, speed limit, lane width, lateral clearance, and other factors that affect
the traffic flow.

D/C analysis is a method for planners to quickly estimate the capacity, delay, level of
service, queue length on various types of highway facilities. It is easy to use and is capable of
generating a quick estimate of the order of magnitude of the delay, queue length, etc. However,
it can only be used for small scale, isolated work zones, where their impact is limited to the
highway under rehabilitation. This is because the D/C analysis procedure does not take into
account mode and route diversions, i.e., it does not model traffic on any alternate modes/routes.
It also does not output performance measures related to environmental factors such as fuel

consumption, emission and noise.

2.1.2 QuickZone

QuickZone is a software tool developed by Mitretek Systems Inc for the Federal Highway Ad-
ministration (FHWA) to estimate traffic delay at construction work zones. It may be viewed as
an extension of the D/C analysis method as it also uses the HCM 2000 method to calculate work
zone capacity and delay. QuickZone allows users to model a simple corridor network with nodes
and links. Link characteristics such as capacity reduction due to work activities at different
times of the day and day of the week are represented. User responses to travel delay include
percentages of mode shift, canceled trips, delay departure and diversion to alternate routes.
Traffic management measures are represented by lane widening, reversible lanes, traveler infor-
mation posted on changeable message signs, ramp metering and so forth. Users can also specify
a capacity increase at signalized intersections, assuming that the signal timing can be adjusted.

QuickZone is a deterministic model for users to estimate work zone traffic impact at the
corridor level. Although it has many built-in traffic management and ITS features, it does
not have an underlying traffic flow model that interact with these features—it simply provides

the user the option of entering what he believes would be the work zone capacity, changes in
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traffic demand, route diversion, and other factors based on his field experience. There is no
model inside QuickZone that automatically models the impact, for example, of a integrated
ramp metering/signal coordination plan on the reduction of travel demand to the work zone
due to traffic redistribution in the road network that contains the work zone. The results from

QuickZone are, therefore, highly dependent on the expert knowledge of its users.

2.1.3 Transportation planning models

Many software tools designed for transportation planning applications have also been used to
assess work zone traffic impact. Some of the examples are Tranplan (by Citilab), Viper/ TP+ (by
Citilab), TransCAD (by Caliper), and EMME/2 (by INRO). These tools were developed for, and
mostly used to study the traffic impact on long-term land use and network changes. Compared
to D/C analysis and QuickZone, they are used to model much larger networks with multiple
origins and destinations, and often multiple transportation modes. Such tools are capable of
modeling mode and route choices based on network equilibrium and other principles. However,
their capabilities of modeling a large network with mode and route choices come at a price of
trading off many other modeling details. As a result, traffic flow and management strategies at
node and/or link levels are not modeled in detail.

Because they are concerned with long-term changes in a network and its demand, trans-
portation planning tools explicitly assume that traffic being modeled is at a steady or equilibrium
state, i.e., they model traffic from one equilibrium to another, but not the process in which each
equilibrium state is reached. For example, it does not model model the growth and decay of
queues in front of the work zone, nor changes in traffic flow patterns between peak and off-peak
periods. In other words, the dynamic change in traffic operations is not considered in a trans-
portation planning model. Although they capture network wide traffic impact and are easy to
code, calibrate and analyze, transportation planning models are deemed too coarse for modeling
the impact of short-term, dynamic network changes such as a work zone, where time is usually
not long enough for the establishment of a new equilibrium in the network. They can be com-
bined, however, with other modeling tools to take advantage of their computational efficiency
and network scope. It should also be noted that many transportation planning models produce

performance measures related to environmental factors such as emissions and fuel consumption.

2.1.4 Traffic simulation models

Traffic simulation models attempt to describe the flow dynamics of traffic in a road network.
They are capable of modeling various operational strategies, such as freeway widening and con-
struction, ramp metering, incident management and traveler information. Traffic simulation
models may be classified into two broad categories: macroscopic and microscopic models. Com-
pared to macroscopic models, microscopic models have more detailed representations of road
networks, vehicle and control activities. In both cases, traffic simulation models require relatively

more input data on road geometry, traffic demand, vehicle composition, driver characteristics
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and control strategy, and also consume more computational resources. The outputs are sensitive
to many parameters related to the driver/vehicle/road environment, and the calibration of such
parameters also requires more efforts.

Macroscopic traffic simulation models basically model traffic evolution based on deter-
ministic relationships of flow/volume, speed and density in a freeway section and between its
neighboring sections. It computes the aggregate traffic quantities of flow, speed and density on
a section by section basis, rather than at the individual vehicle level. Compared with micro-
scopic traffic simulation, macroscopic traffic simulation requires fewer details in the input data,
and is therefore suitable for transportation applications in large networks. Because of the fewer
parameters involved in them, macroscopic simulation models are generally easier to calibrate
than their microscopic counterparts. Examples of popular macroscopic traffic simulation tools
include Transyt-7F (by McTrans) and FREQ (by UC Berkeley). One should note that most
available macroscopic simulation tools are only capable of modeling specific networks such as a
freeway or arterial segment rather than general networks.

Microscopic traffic simulation models simulate the movements of individual vehicles in
a road network, including the car-following and lane changing behaviors. Microscopic traffic
simulation models internally represent a variety of geometric and vehicle/driver characteristics.
The details in road geometry include grade, curvature, superelevation while the vehicle/driver
characteristics include vehicle composition, vehicle length, acceleration and deceleration, fuel
consumption and emission of each vehicle type, driver’s reaction time, aggressiveness, and route
choice behavior, and so forth. For example, the exact location, lane configuration and length
of a lane closure due to maintenance or construction activity can be modeled. As a result of
this level of detailed representation, microscopic traffic simulation models need more input data
(in terms of both quantity and level of detail), more effort in coding the network and setting
up the study scenarios, and more computational resources. They also have more parameters to
be calibrated, and usually a steep learning curve. However, software packages based on micro-
scopic traffic simulation models typically have a good graphical user interface that helps ease
the project development and analysis effort, and more importantly, provides a powerful visual
aid to display the results that even a layman can understand. Because of the latter aspect of
microscopic simulation tools, they have gained considerable popularity in recent years. Exam-
ples of microscopic traffic simulation tools include TSIS-CORSIM (by FHWA), Paramics (by
Quadstone), VISSIM (by PTV), AIMSUN (by TSS) and MITSIM (by MIT).

As revealed by this review, there are a variety of modeling approaches that one can adopt
to assess the traffic impact of a work zone. Yet two critical issues remain to be resolved for all
these approaches, one is the accurate modeling of work zone capacity and the other is the reliable
estimation of demand diversion. As we know, work zone capacity is one of the major factors in
estimating travel delay regardless which traffic model one uses. In all the tools discussed above,
work zone capacity is either provided by users or simply treated proportional to the number of

lanes still open. In reality, the capacity of a work zone highly depends travelers merging behavior
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right before the work zone. Yet research is this area is still in its infancy. With respect to travel
demand diversion, it carries two distinct meanings in the context of work zone traffic studies: (1)
reduction of the total travel demand due to trip cancelations or shifts to alternative modes; (2)
temporal and spatial redistribution of the travel demand in the network. This redistribution is
primarily due to travelers’ departure time and route changes to avoid heavily congested periods
and/or road segments. These adjustments will affect the travel delay through the work zone and
the network as a whole. The D/C analysis procedure could take into account trip reductions
and departure time changes externally but does not consider diversions to alternate routes at
all, while in Quickzone, without an explicit model, demand diversion to alternate departure
times, modes and routes is only superficially considered. On the other hand, planning and
simulation tools to-date have the capability of handling route diversions but departure time
(peak spreading) changes are either completely ignored (in planning models) or only partially

captured (in simulation models).

2.2 Work Zone Capacity

We provide in this section a brief review of studies devoted to work zone capacity, which may
serve as an initial guideline for users to specify reasonable work zone capacity values. A more
detailed study on work zone capacity is currently underway and will be reported elsewhere!.

Before reviewing various studies on the capacity of a work zone, it is perhaps necessary
to first give a precise definition of a “ work zone”. Karim & Adeli (2003) defines a work zone
simply as ”a region within an existing highway’s roadway where active maintenance, rehabil-
itation, and/or reconstruction work is carried out.” This definition views the work zone from
the contractor’s or pavement engineer’s perspective. HCM 2000 defines work zone as ”a seg-
ment of highway in which maintenance and construction operations impinge on the number of
lanes available to traffic or affect the operational characteristics of traffic lowing through the
segment”. This definition takes into account the traffic behavior associated with the work zone.
Obviously, the traffic impact of a work zone far exceeds the area demarcated by construction
activities. For example, traffic diverted to alternative routes has an impact on other users of
these routes. Thus, from a traffic analysis point of view, the definition provided by HCM 2000
is preferable.

As for the definition of the flow capacity of a work zone, two different approaches are
found in the literature. The first approach defines and measures work zone capacity at a lo-
cation immediately upstream of the bottleneck caused by the lane closure and/or construction
activity of a work zone. Dixon, Hummer & Lorscheider (1996) defines work zone capacity as
”the flow rate at which traffic behavior quickly changes from uncongested conditions to queued
conditions”. Jiang (1999) considers work zone capacity as ”the traffic flow rate just before a
sharp speed drop, followed by a sustained period of low vehicle speed and fluctuating traffic

flow rate.” Maze, Kamyab & Schrock (2000) define work zone capacity as ”the volume of vehi-

! A separate research project funded by Caltrans exclusively deals with this topic.
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cles that can pass through a work zone lane closure prior to and during congested operations.”
The above definitions indicate that work zone capacity should be measured as the maximum
uncongested flow rate immediately upstream of the work zone bottleneck. The second approach
adopts the concept of queue discharge rate. Krammes & Lopez (1994) define and measure work
zone capacity as "the mean queue-discharge rate at a freeway bottleneck.” Similarly, Dudek &
Richards (1982) measure work zone capacity while ”queues were formed upstream from the lane
closures and thus essentially represent either the capacities of the bottlenecks created by the lane
closures or the effects of drivers starting because of the work crew and machinery.” Al-Kaisy &
Hall (2002) provides a clearer definition of work zone capacity as ”the mean queue discharge flow
rate from the bottleneck that was located at the end of the transition area.” Later, Ak-Kaisy
& Hall (2003) treats work zone capacity as equivalent to the mean queue discharge flow rate
(from the bottleneck caused by the work zone). Obviously, the queue discharge rate can only
be measured at downstream of the bottleneck, within the work zone.

HCM 2000 describes the capacity of a general road segment as ”the maximum sustainable
flow rate at which vehicles or persons reasonably can be expected to traverse a point or uniform
segment of a lane or roadway during a specified time period under given roadway, geometric,
traffic, environmental, and control conditions; usually expressed as vehicles per hour, passenger
cars per hour, or persons per hour.” The first approach of "maximum uncongested flow rate”
does not appear consistent with notion of ”sustainable flow rate” as defined in the HCM 2000.
This is because traffic at this maximum uncongested flow rate is unstable, and can change into
congested flow or queuing state with minimal disturbance. Moreover, due to traffic compression
inside a queue, the flow rate at different locations inside a queue can be quite different. On the
contrary, the queue discharge rate does not fluctuate significantly with time as long as there is
a queue formation upstream, and it is this rate that controls the delay experienced by vehicles
leaving the queue. We therefore suggest that the queue discharge rate inside a work zone be
used as the capacity of the work zone, not the flow rate inside the queue formed upstream of
the work zone.

The capacity of a work zone is affected by a variety of factors. Several studies (Dudek
& Richards 1982, Rouphail & Tiwari 1985, Krammes & Lopez 1994, Dixon et al. 1996, Maze
et al. 2000, Ak-Kaisy & Hall 2003, Karim & Adeli 2003) reported the following factors to have
effects on work zone capacities
1) speed limit
2
3

(
(2) number of lanes

(3) lane width

(4) proximity to ramp (interchange density)
(5) pavement grade

(6) percentage of trucks
(7) driver familiarity
(8) work zone location (rural or urban)
(9)

9) work zone layout (e.g., lane merging, lane shifting, and crossover)



CHAPTER 2. LITERATURE REVIEW 10
10) number of lane closures
11) length of closure

12) work zone duration (long term or short term)

15) work day (weekday or weekend)
16

17) pavement conditions (dry, wet, or icy)

(
(
(
(13) work intensity (type of work)
(
(
(16) weather condition

(

)
)
)
14) work time (daytime or night)
)
)
)

The first seven factors are similar to those used in the level of service analysis in HCM 2000,
while the subsequent ones in the list, besides weather and pavement conditions, are specifically
related to the characteristics of the work zone. When performing a work zone traffic impact
assessment, we suggest users to take into account the effects of the above factors to obtain a
reliable estimate of the capacity of the work zone in consideration. If no detailed statistics are
available, it is suggested that the value of 1500-1600 pc/ph/pl can be used to calculate work zone
capacity ( a variety of studies show that the range of work zone capacity per lane is 1200-1800

pc/ph/pl).

2.3 Travel Demand Diversion Under Work Zone Conditions

It is expected that travel demand patterns during road constructions usually differ from those
before constructions began because the anticipated or actual longer delays due capacity reduction
at the work zone area tend to encourage travelers to seek alternative modes, departure times
and/or travel routes to avoid longer delays. Usually the day to day traffic is considered to
be in some kind of equilibrium, baring the occurrences of special events such as incidents or
road rehabilitation work. In such an equilibrium, it is believed that no traveler can improve
his/her travel time by unilaterally change his/her travel choice (Wardrop 1952). As a contrast,
when there are road constructions, the original network traffic equilibrium can be disrupted if
the construction activities lead to longer travel delays. Travelers, especially those who travel
through the work zone, will adjust their trip choices to avoid potentially longer delays.

While there have been extensive efforts devoted to the study of network traffic equilibrium
(Wardrop 1952, Vickrey 1969, Hendrickson & Kocur 1981, Smith 1984, Daganzo 1985, Newell
1987, Kuwahara 1990, Arnott, De Palma & Lindsey 1990, Friesz, Bernstein, Smith, Tobin &
Wie 1993, e.g.,), the study of the travel demand diversion during road construction is still in its
infancy and calls for significant advancement. In practice, most work zone traffic impact studies
either use the daily travel demand pattern as is or arbitrarily assume a diversion rate (Lee &
Yu 2005, Chu, Kim, Chung & Recker 2005, e.g.,). Some psychometric studies do analyze the
diversion behavior of travelers in the presence of temporal road capacity reductions and traveler
information systems (Khattak 1993, Khattak, Kanafani & Colletter 1994, Peeta, Ramos &
Pasupathy 2000, Peng, Guequierre & Blakeman 2004, e.g.,), but they have never been compared



CHAPTER 2. LITERATURE REVIEW 11

with the actual diversion behavior under real-world conditions. Some field studies describe the
actual diversion pattern during road constructions for specific work zone projects (Horowitz,
Weisser & Notbohm 2003, Chu et al. 2005, Lee & Kim 2006, e.g.,), but there are usually
insufficient data to draw firm conclusions about the combined effects of the multiple entangling
factors on demand diversion.

In the next few sections, we perform a comprehensive review of various studies on travel
demand diversion. This review serves as a basis for developing our own travel demand diversion

model in Chapter 3.

2.3.1 Psychometric studies of traffic diversion

Most psychometric studies of traffic diversion were carried out in the context of studying travel-
ers’ diversion behavior in the presence of different information dissemination strategies. These
studies conduct traveler behavior surveys (stated preference surveys in most cases) and for-
mulate discrete choice models to characterize the impact of multiple factors on travelers’ di-
version behavior. However, since the diversion models derived from these studies usually in-
volve qualitative or conceptual variables which are difficult to evaluate without a large-scale
survey, these models are generally difficult for direct application in work zone traffic impact
studies. In the past decade, extensive research efforts (Heathington, Worral & Hoff 1971,
Daniels, Levin & McDermott 1976, Dudek 1979, Dudek, Huchingson & Brackett 1983, Huch-
ingson, Whaley & Huddleston 1984, Shirazi & Stesney 1988, Haselkorn, Spyridakis, Conquest
& Barfield 1989, Mahmassani, Caplice & Walton 1990, Allen, Ziedman, Rosenthal, Stein, Tor-
res & Halati 1991, Khattak 1991, Khattak 1993, Khattak et al. 1994, Peeta et al. 2000, Peng
et al. 2004, e.g.,) have been devoted to such studies. Here, we only list the major findings from
these studies, and readers may refer to (Khattak 1991) for more details.

Travelers’ diversion decisions are closely related to the delays on their regular routes.
Generally speaking, the longer the delay, the higher the diversion rate (Heathington et al. 1971,
Huchingson et al. 1984, e.g.,). However, these behavior studies in the literature seem to indicate
a large variation in travelers’ diversion response to traffic delay. For example, the study by
Huchingson et al. (1984) reveals that 50% of the travelers were willing to divert in response to
a 6 minute delay, while a survey conducted in Washington by Haselkorn et al. (1989) reported
that the delay ranged from 13.5 and 27.4 minutes before half of the travelers would divert. The
large variation in travelers’ response to delay may be due to situational factors other than the
incurred delay.

Besides the delay on travelers’ regular route, traveler information disseminated through
commercial radio, highway advisory radio and changeable message signs were also found to
increase the likelihood of diversion (Heathington et al. 1971, Daniels et al. 1976, Khattak 1993,
Peeta et al. 2000, Peng et al. 2004). Furthermore, quantitative information (e.g., expected
delay or point-to-point travel times) seem to induce a higher diversion rate than qualitative

information (e.g., subjective evaluation of congestion) (Heathington et al. 1971, Dudek, Messer
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& Jones 1971).

In addition, prescription information regarding diversion instructions has also been found
to encourage diversion (Dudek, Weaver, Hatcher & Richards 1978, Richards, Stockton & Dudek
1978, Roper, Zimowski & Iwamasa 1984). Other factors influencing diversion include the travel
time difference between preferred and alternate routes (Huchingson & Dudek 1979), familiarity
of alternate routes (Haselkorn et al. 1989) flexibility in arrival and departure time at work
(Mahmassani et al. 1990), and individual characteristics - younger, male and unmarried travelers
were more likely to divert (Mahmassani et al. 1990, Allen et al. 1991).

2.3.2 Diversion analysis in practical projects

Still, some other studies focus on traffic diversion patterns in specific projects, with an objective
of evaluating the effectiveness of information systems such as ADAPTIR (Automated Data Ac-
quisition and Processing of Traffic Information in Real-time), CHIPS (Computerized Highway
Information Processing System), Smart Zone, and TIPS (Traffic Information & Prediction Sys-
tem), to encourage diversion. Different from the psychometric type of studies in which travelers’
diversion behavior are studied in hypothetical settings, studies in this category use real diver-
sion data measured from the field. These studies often do not produce a diversion model but
do reveal some insights and provide valuable data for validating any demand diversion model
developed from the psychometric approach.

Although most studies in the latter category show that the presence of AWIS (Advanced
Work Zone Information Systems)indeed facilitate diversion, the rates of diversion in different
CWZ projects are very different. For example, a study in Nebraska with an AWIS by Fontaine
(2003) indicated a 3% diversion rate, while a similar study in Kentucky by Agent (1999) reported
no significant diversion.

Horowitz et al. (2003) reported a diversion rate between 7% and 10% of the freeway traffic
in a work zone project in Wisconsin. The work zone in this study is about 12 miles long and
located on 1-94. The original three travel lanes were reduced to two lanes during the road work.
A traveler information system named TIPS was installed in the work zone area displaying the
estimated travel time and distance to the end of the work zone. In this project, there is one
particularly attractive alternate route which is a frontage road running the full length of the
work zone on the west side of the freeway.

Chu et al. (2005) evaluate the effectiveness of an AWIS deployed in a work zone on I-5
in southern California. The work zone site in this project is about 1.3 miles. The road con-
struction left three lanes in each direction open to motorists after the closure of one southbound
lane and one northbound lane on the median side. The Old Road parallel to I-5 in the work
zone area is suggested as the alternative route. A proportion-based method is applied in this
study to compare the traffic splits at each diversion points. Although no specific diversion rate
is provided, the author reported the observation of a significant increase in the diverted traffic

demand at one of the two measurement locations.
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Based on the review results provided in this chapter, we conclude that an effective work

zone traffic impact assessment tool should have the following features:

o Geographical scope of the study area. Work zone traffic impact studies may cover
geographical scope of a freeway segment, a freeway corridor (with or without a parallel
arterial), or a network with several freeways and major arterials. The impact area depends
on the location and size of the work zone, and the network topology of the surrounding
area. A general work zone traffic analysis tool should be able to model both an isolated
work zone on a freeway stretch, or a single or multiple work zones in a corridor or large
urban network, such that the impact of the work zone(s) on all routes in the network can

be assessed.

e Traveler responses to various traffic management measures. Travelers may re-
spond to the capacity reduction in the work zone by: no changes their travel choices,
divert to an alternative route, change the trip departure time, or change in travel mode.
The method or tool must be able to predict and model these behavioral responses. That
is, it can model travelers’ responses to capacity reduction by work zones and traffic man-
agement measures. The presence of traffic management measures such as integrated signal
control, traveler information system, lane re-stripping, media campaign add to the com-
plexity of travelers’ response behavior. The change in the traffic low pattern due to
travelers’ behavior responses have not been adequately modeled in existing methods and

tools.

e Performance measures. The method or tool must be able to produce the desired out-
puts that serve as the performance measures of the work zone traffic analysis. The output
may be related to efficiency (e.g., travel time and delay), mobility (e.g., speed), produc-
tivity (e.g., loss in work hours), safety (e.g., increase in accident risk) and environmental
measures (e.g., fuel consumption, traffic noise and vehicle emissions) for a particular traffic

management strategy.

e Cost effectiveness. It should be cost effective and easy to use. This refers to the time
and effort to collect all the necessary data, set up the model, calibrate the appropriate
parameters, and perform the necessary analysis. All the efforts involved in the acquisition

of and conducting all the modeling works should fit within the time and cost budget.

In the next few chapters, we will report a newly developed CWZ traffic analysis tool that

has these desired features.



Chapter 3

Trafthic Diversion—case studies and a
diversion model

This chapter studies traffic diversion in the presence of construction work zones. A comprehen-
sive diversion analysis on two work zone projects in California, the I-15 Devore and the I-710
Long Beach reconstruction projects, is performed, and a theoretical model to characterize traffic

diversion is proposed at the end of this chapter.

3.1 Diversion Analysis for the I-15 Freeway Devore Project

3.1.1 Project description

The I-15 Devore project is located on the I-15 Freeway between the I-10 Freeway and the I-215
Freeway in San Bernardino County, California. The I-15 Freeway is a heavily traveled highway
that connects Los Angeles/Orange County areas in Southern California to the suburban areas in
the High Desert and Las Vegas, Nevada. This segment of the freeway carries 80,000 veh/day in
both directions. Beside commuting trips between the high desert communities and Los Angeles,
it also carries high volume of inter-city traffic to and from Las Vegas on weekends. The I-
15 Freeway is also a major truck route for interstate goods movement, from the Port of Los
Angeles/Long Beach to the neighboring states.

Caltrans District 8 rebuilt a 2.6 miles (4.2 km) section of the deteriorated concrete truck
lanes (rightmost lanes) along the I-15 freeway between the Sierra Avenue intersection and the I-
215 Freeway interchange (in both directions). The construction was carried out on two segments:
Segment 1 is a 1.6 miles (2.5 km) of eight-lane section from the Sierra Avenue intersection to
the Glen Helen Parkway intersection, while segment 2 is a 1.1 miles (1.7 km) of six-lane section
from the Glen Helen Parkway intersection to the I-215 freeway interchange.

The District 8 of Caltrans had earlier decided on the following construction plan. The
construction period was divided into two phases. Phase one was from Oct. 3, 2004 to Oct. 11,
2004 (about 9 days), and phase two from Oct. 23, 2004 to Oct. 31, 2004 (about 9 days). In

each phase, one direction of the freeway(known by Caltrans as the construction roadbed) was
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fully closed for construction, and traffic in this direction will be diverted into the remaining and
opposing lanes (known as traffic roadbed) through median crossovers. The freeway lanes in the
opposite direction will be reconfigured to carry two-way traffic separated by moveable concrete
barriers (MCB). For example, Fig. 3.1 below shows a segment with eight traffic lanes (both
directions combined), with the four right lanes for northbound traffic and four left lanes for
southbound traffic. When the four lanes on the right hand side were closed for reconstruction,
the four left lanes were reconfigured to be a four lane highway with two lanes in each direction,

separated by a temporary barrier.

rafficiRoadbed

S1| L1 jJL2 §L3 J L4 |S2

VﬂE‘COﬁS;-’
SBTRAFFIC | NB TRAFFIC ACCESS RUCTION

(a-1) plan view: Full-closure

Figure 3.1: Construction plan for I-15 Freeway work zone

The traffic management plan for this project was as follows: a proactive public outreach
program posting online real-time travel times through the construction work zone area was im-
plemented by Caltrans to encourage travelers to make diversion decisions before their departure.
In addition, an en route Automated Work zone Information System (AWIS) was installed in the
field to further divert travelers to alternative routes when the I-15 corridor was congested. The
AWIS used in this project consists of three major components: Remote Traffic Microwave Sensor
(RTMS) traffic monitoring devices, Portable Changeable Message Signs (PCMS), and the server
station. Three traffic-monitoring stations for northbound and two for southbound were located
at 1.6 km intervals upstream of the start of the work zone. Another traffic-monitoring device was
placed on I-10 Eastbound to check its traffic condition as a main detour route. Three PCMSs
were installed for northbound traffic and one for the southbound traffic. Each was located at a
merging point of an alternative route and the I-15 corridor to guide travelers to bypass the work
zone by taking alternative routes. The estimated travel time (Northbound: from the I-210/1-15
junction to the I-215/115 junction, 15.2 km; Southbound: from the I-15/SR-138 junction to the
1-15/1-210 junction, 26.1 km) was displayed on the PCMSs at a 10-min frequency. The location

map and the traffic management plan of the I-15 freeway project is shown in Fig. 3.2.
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Figure 3.2: Location and traffic management plan of the I-15 project

As we can see, the road network around the work zone is approximately triangular con-
sisting of the I-10, I-15, and I-215 freeways. The possible diversion routes for the I-15 Freeway’s
northbound traffic include: (1) first the I-10 freeway then the I-215 freeway; (2) first the I-210
freeway then the I-215 freeway; (3) first the I-15 freeway off-ramp right before the work zone then
local streets (e.g., Sierra Ave, Riverside Ave), then the I-215 freeway. For the I-15 southbound
traffic, the only possible diversion route is via the I-215 freeway, followed by the I-10 freeway
before merging back to the I-15 freeway. The additional detour distance for southbound traffic
is about 10 miles.

3.1.2 Data source

Traffic data from the following four sources were used to analyze traffic diversion in the I-15
Devore reconstruction project: (1) the two RTMSs placed at the northbound and southbound
entrances of the work zone; (2) the six RTMSs located along the I-15 freeway corridor as well as
along the I-10 freeway; (3) the PeMS loop detector (indexed 808392) measuring the northbound
traffic on the upstream of the work zone; and (4) rubber tubes placed on local streets. The
dates when the measurements were performed and the measurement resolutions for all the data

sources are listed in Table 3.
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Table 3.1: Data collection days and sampling time intervals for the I-15 work zone

Data source Days Resolution
RTMS for CWZ (R(a) and R(b))|Sept. 30 - Oct 17 5 min
RTMS for AWIS (R(1)- R(5)) Oct. 6 - Nov. 2 1 hour
Local street Rubber tube Sept 26, 27, 30, 31 Oct 3,4, 7, 8] 5 min
PeMs loop detector 808392 Sept 30 - Oct 31 5 min

Note: the traffic data for the northbound direction is incomplete
due to an traffic accident happening to RTMS (b)

The field data collected from different sources were processed before the analysis. Missing
data points were filled with interpolated values.

For I-15 SB, the best traffic measurement location among R(1), R(2) and R(a) to analyze
the southbound demand pattern is R(1), which is the least likely to be affected by the queue
developing from the CWZ. Unfortunately, the quality of the data from R(1) is unsatisfactory
because of the following reasons: 1) From Sept. 26, 2004 to Nov. 16 2004, R(1) only has two
days with complete data while R(2) has 14 days and R(a) has 44 days; 2) poor data consistency
between R(1) and R(2). Since there are no major entrances or exits on I-15 SB between R(1)
and R(2), the daily traffic volume measured at R(1) should be comparable with that measured
at R(2). However, for the only two days when R(1) had complete data (Oct. 18 and Oct. 24),
the difference in total daily traffic volume measured at R(1) and R(2) is as high as 54.7% and
10.9%, respectively. 3) The time resolution of data at R(1) is one hour, which may not be
sufficient to study temporal redistribution in traffic demand, while data at R(a) has a higher
data resolution of five minutes. Because of these reasons, we pick R(a) as the major data source
to analyze the demand diversion in the southbound direction.

Similarly, for I-15 NB, the data from PeMS loop detector 808392 is the best to study
the northbound travel demand pattern among PeMS loop detector 808392, R(5), R(4), R(3),
and R(b). Luckily, the data quality of PeMS loop detector 808392 is the best among all the
five detectors since it has 31 days with complete data (Sept. 30 - Oct. 30), while R(5) has 15
days, R(4) 18 days and R(b) 8 days. Hence, we select PeMS loop detector 808392 as the major
data source to study the northbound demand diversion, and other data sources will be used as

complements when necessary.

3.1.3 Travel demand diversion

To simplify the analysis procedure, we first compare the total daily travel demand for regular
days (i.e., days without road constructions) and construction days (i.e., days with road con-
structions). After that, the temporal distribution of the within-day travel demand for regular

days and construction days are compared in detail.
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Daily travel demand diversion

Considering the demand fluctuations among different weekdays, the daily traffic volumes are
compared for each weekday separately. Fig. 3.3 illustrates all the data points of daily traffic
volumes for I-15 SB. The average daily traffic volumes for all the weekdays and the demand
diversion rate are calculated in Tab. 3.2. Similarly, the data points of daily traffic volumes for

I-15 NB and the average values are shown in Fig. 3.4 and Tab. 3.3. respectively.
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Figure 3.3: Daily traffic volume comparison for I-15 SB

Table 3.2: Average travel demand diversion rate for I-15 SB

Sun Mon Tue Wed Thu  Fri Sat  Avg.
(1) ADT for regular days 55,041 53,985 49,943 51,396 54,406 55,936 48,082 52,600
(2) ADT for construction days|51,904 54,991 48,821 50,588 54,575 52,191 50,436 51,943
r=(1)/(2) 094 1.02 098 098 100 093 105 0.99
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Figure 3.4: Daily traffic volume comparison for I-15 NB



CHAPTER 3. TRAFFIC DIVERSION—CASE STUDIES AND A DIVERSION MODEL 19

Table 3.3: Average travel demand diversion rate for I-15 NB

Sun. Mon Tue Wed Thu  Fri Sat  Avg.
(1) ADT for regular days 48,528 51,543 52,724 48,601 58,887 65,326 63,658 57,334
(2) ADT for construction days|50,887 49,119 47,783 46,642 52,145 58,023 58,445 52,032
r=(1)/(2) 1.05 095 091 096 089 0.89 092 091

From Fig. 3.3 - 3.4, Tab. 3.2 - 3.2, we can see that the daily travel demand diversion in
this project is trivial. For I-15 SB, the average daily demand reduction is one percent. Namely,
there are no significant difference in the daily traffic volume during a regular day and that
during a construction day. For I-15 NB, a slight demand reduction can be observed and the
average demand reduction is 9%. Except Sunday, the average weekday traffic volume during
construction days is always less than that during a regular day.

Two additional data analyses are performed to further verify the small demand reduction
in this project. First, the daily traffic volumes on local streets are summarized to see whether
there is a significant change in the traffic volumes between construction days and regular days.
In addition, the traffic splits at three major diversion points, namely, the junction of I-15 SB
and I-215 SB, the junction of I-15 NB and the off-ramp to Riverside Ave. and Sierra Ave.,
and the junction of I-15 NB and I-10 NB are also analyzed. Evidently, if there are significant
demand diversions for the I-15 SB/NB through traffic, the proportion of the through traffic at
those junctions should decrease.

Fig. 3.5 depicts the daily traffic volumes on local streets for both regular days and con-
struction days. The x-axis represents different traffic measurement locations. As we can see, the

daily traffic volumes on construction days are only slightly higher than those on regular days.
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Figure 3.5: Daily traffic volume comparison for local streets
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Fig. 3.6 illustrates the data points of the daily through traffic proportions at the junction

of I-15 SB and I-215 SB. The average daily through traffic proportions for all the weekdays are
calculated in Tab. 3.4.
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Figure 3.6: Through traffic proportion at the junction of I-15 SB and 1-215 SB

Table 3.4: Average through traffic proportion at the junction of I-15 SB and I-215 SB

Sun Mon Tue Wed Thu Fri Sat Avg.
Avg. through traffic prop. for regular days 0.76 0.72 0.70 0.71 0.72 0.71 0.72 0.72
Avg. through traffic prop. for construction days|0.73 0.71 0.69 0.76 0.71 0.67 0.71 0.71

As we can see from Fig. 3.6 and Tab. 3.4, except Wednesday (only one data point is
available for construction days), the through traffic proportions during construction days are
slightly less than those during regular days for all other weekdays.

Fig. 3.7 illustrates the data points of daily through traffic proportions on the junction of I-
15 NB and I-15 NB off-ramp to Sierra Ave. and Riverside Ave., based on the traffic data collected
by R(b). The average daily through traffic proportions for all the weekdays are calculated in
Tab. 3.5.
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Figure 3.7: Through traffic proportion at the junction of I-15 NB and 1-15 NB off-ramp
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Table 3.5: Average through traffic proportion at the junction of I-15 NB and I-15 NB off-ramp
Sun Mon Tue Wed Thu Fri Sat Avg.
Avg. traffic ratio for regular days N/A N/A 092 091 N/A N/A 0.92 0.92
Avg. traffic ratio for construction days|0.92 0.91 N/A 0.90 0.89 0.89 N/A 0.90

As we can see from Fig. 3.7 and Tab 3.5, there are insufficient data available to draw
meaningful conclusions regarding the changes in the through traffic proportions. However, based
on the limited available data, we can still observe a slight reduction in the through traffic
proportion for construction days versus regular days.

Fig. 3.8 illustrates the data points of daily through traffic proportions on the junction of
I-15 NB and I-10 NB, based on the traffic data collected from R(5) and R(6). The average daily
through traffic proportions for all the weekdays are calculated in Tab. 3.6.
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Figure 3.8: Through traffic proportion at the junction of I-15 NB and I-10 NB

Table 3.6: Average through traffic proportion at the junction of I-15 NB and I-10 NB
Sun Mon Tue Wed Thu Fri Sat Avg.
Avg. traffic ratio for regular days N/A N/A 0.39 0.38 0.37 N/A N/A 0.38
Avg. traffic ratio for construction days|N/A 0.38 0.36 0.39 0.39 N/A N/A 0.38

Similar to the previous analysis, there are still not enough data for deriving firm conclusions
about the changes in through traffic proportions. The available data seem to indicate that there
are no significant changes in the through traffic proportion at this junction.

Based on the above analyses, we can conclude that both I-15 SB and I-15 NB only have
slight daily traffic demand reductions. The possible reasons for this are that the major users of
this corridor are commuters whose travel demand is relatively inelastic with respect to the en-
route travel time, and that the triangular network does not have comparable alternative routes
for travelers to divert. The slightly higher reduction in the northbound traffic demand than
the southbound traffic maybe due to the fact that there are more PCMSs for diverting I-15 NB
traffic than I-15 SB. It should be noted, however, the lack of data makes it difficult to draw
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firm conclusions and in order to have conclusive diversion results, more project data should be

collected in future CWZ projects.

Temporal travel demand redistribution within a day

Although the above analysis shows that there are only slight travel demand diversions for both
I-15 SB and I-15 NB during construction days, the temporal distribution of the travel demand
during a construction day can be substantially different from that during a regular day. We
now compare the temporal travel demand patterns for regular days and construction days to
see whether departure time changes exist during construction days.

To examine the possible changes in departure times, we picked four typical days for I-15
SB and I-15 NB respectively, two of which represent regular days and the other two represents
construction days. Based on the availability and quality of the data, for the I-15 SB traffic on
weekdays, we picked one day during the first construction period, one day between the first and
second construction period, one day during the second construction period, and one day after
the second construction period; for the I-15 NB traffic on weekdays, we selected one day before
the first construction period, one day during the first construction period, one day between the
first and second construction period, and one day during the second construction period.

The temporal demand patterns on I-15 SB on different weekdays are illustrated in Fig. 3.9
- Fig. 3.15. Note that for some weekdays (Tuesday, Wednesday, Thursday, Friday), only three
typical days can be found for the comparison. The temporal travel demand patterns of I-15
NB on different weekdays are illustrated in Fig. 3.16 - Fig. 3.22. Note that for some weekdays
(Monday, Tuesday, Wednesday), only three typical days can be found for the comparison.
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Figure 3.9: Temporal travel demand patterns on I-15 SB (Monday)
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Figure 3.10: Temporal travel demand patterns on I-15 SB (Tuesday)
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Figure 3.11: Temporal travel demand patterns on I-15 SB (Wednesday)
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Figure 3.12: Temporal travel demand patterns on I-15 SB (Thursday)
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Figure 3.13: Temporal travel demand patterns on I-15 SB (Friday)
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Figure 3.14: Temporal travel demand patterns on I-15 SB (Saturday)
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Figure 3.15: Temporal travel demand patterns on I-15 SB (Sunday)
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Figure 3.16: Temporal travel demand patterns on I-15 NB (Monday)
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Figure 3.17: Temporal travel demand patterns on I-15 NB (Tuesday)
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Figure 3.18: Temporal travel demand patterns on I-15 NB (Wednesday)
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Figure 3.19: Temporal travel demand patterns on I-15 NB (Thursday)

600
———- Before Ist const. ———- During Ist const.
500

Between Ist and 2nd const. === During 2nd const.

400

300

Flow (veh./5 min)

200

100

0
0:00 200 400 6:00 800 1000 12:00 14:00 16:00 18:00 20:00 22:00 0:00

Time

Figure 3.20: Temporal travel demand patterns on I-15 NB (Friday)
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Figure 3.21: Temporal travel demand patterns on I-15 NB (Saturday)
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Figure 3.22: Temporal travel demand patterns on I-15 NB (Sunday)

The travel demand patterns in Fig. 8 to Fig. 21 reveal the following three common

properties:

e Most demand diversions happen only during peak time periods. In our case, the major
demand diversion for I-15 SB occurs during the morning peak while the demand diversion
for I-15 NB occurs during the afternoon peak. The 5-min traffic flows during off-peak
time are almost the same for construction days and regular days. This is understandable
because during off-peak time when no congestion exists there is no incentive for travelers

to change their departure times.

e There is a clear adjustment process among travelers as the work zone project goes on
for both I-15 SB and I-15 NB. During the first construction period, there are only trivial
demand reduction; during days between the first and second construction periods, there
is a slight increase in the travel demand, but the demand level is still lower than that of a
regular day (days before the first construction period or days after the second construction
period); when the second construction period begins, the demand level decreases again,
and this time it is even lower than that of the first construction period. This demand
fluctuation may be explained by travelers’ trip choices. During the first construction
period, travelers have not yet experienced the congestion incurred by the work zone yet.
Hence, only a very small proportion of travelers will divert. During the second construction
period, because most travelers have already accumulated enough knowledge of the traffic

conditions through the CWZ, more travelers will decide to divert than before.

e A slight peak spreading for both I-15 SB and I-15 NB can be observed. For example, if we
compare the I-15 SB travel demand pattern during the second construction period with
that on a regular day, although the demand level of the morning peak time during the
second construction period is lower than that during a regular day, the peak time ends
slightly later during the construction period. As is the case for all the weekdays from
Monday to Thursday. Furthermore, we are sure that this peak spreading is not due to

the morning peak congestion because, according to the travel demand pattern during the
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first construction period, the I-15 SB corridor through the CWZ can accommodate much
higher flow than that is present during the second construction period. For I-15 NB, the
shift in demand due to earlier departures during the afternoon period seems to be more

pronounced than that due to later departures (Monday, Tuesday, Thursday, Friday).

3.2 Diversion Analysis for the I-710 Long Beach Freeway Re-
construction Project

3.2.1 Project description

The I-710 Long Beach freeway project involved the rehabilitation of 2.75 miles of the Long Beach
(I-710) freeway, between the Pacific Coast Highway (State Route 1) and the San Diego (I-405)
Freeway. The I-710 freeway carries more than 164,000 vehicles per day in both directions.
Approximately 13% of the vehicles are heavy trucks. It is the major freeway connecting the
Port of Long Beach and Port of Los Angeles to the southwestern states. On weekends, the
traffic volume is approximately 122,000 vehicles per day (both directions combined), with a
peak volume of 4,300 vph in one direction. The location of the work zone project is illustrated
in Fig 3.23.
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Figure 3.23: Location of the I-710 project

Traffic closures were performed during eight weekends from March 29, 2003 to July 13,
2003. Tab. 7 lists the construction working schedule of all the weekends during this period.
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Each lane closure lasted 55 continuous hours, from 10:00 p.m. on Friday to 5:00 a.m. on
Monday. In each construction weekend, the counter-flow traffic system with one side of freeway
completely closed for construction and traffic diverted to the traffic roadbed on the other side
through median crossovers. The outside shoulder was temporarily converted to a main traffic
lane to provide two lanes in each direction, compared to the normal three. During the initial
eight hours of the working weekend, full-closure of the freeway for both directions is required
for the preparation of traffic division. At the end of the weekend closure, both directions of the
freeway are completely closed again for six hours to relocate the moveable concrete barriers and
lane configurations before reopening the freeway. The construction plan in the work zone area
is shown in Fig. 3.24.
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Figure 3.24: Construction plan for the I-710 work zone

3.2.2 Data source

Compared to the I-15 Devore reconstruction project, this project provides less traffic data for
studying traffic diversion. The only useable traffic data are from two RTMSs measuring the
through traffic in both the southbound and northbound directions in the work zone. Both
RTMSs measured the traffic flow, occupancy and speed, at five-minute intervals, in all the
weekends from Mar. 29 - July 13. The location of the traffic measurement devices is shown in
Figure 4.

The time resolution of the data is 5-min. All the missing data were first filled with

interpolated values before the travel demand diversion analysis was carried out.
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3.2.3 Traffic diversion
We adopt a similar analysis procedure as the one used for the I-15 Devore project. Namely,

the daily travel demand diversion rate is first analyzed and then the within-day temporal travel

demand patterns for construction days and regular days are compared in detail.

Daily Traffic Diversion

Fig. 3.25 and Fig. 3.26 plot the daily traffic volumes of the I-710 freeway, in the southbound
and northbound direction respectively, for both Saturday and Sunday. The average daily traffic

volumes and the demand diversion ratios are calculated in Tables 9 and 10.
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Figure 3.25: Daily traffic volume comparison for I-710 SB

Table 3.7: Average travel demand diversion rate for I-710 SB

Sat  Sun  Avg.
ADT for regular days 48,254 41,278 44,766
ADT for construction days|31,626 30,015 30,820
r 0.66 0.73 0.69
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Figure 3.26: Daily traffic volume comparison for I-710 NB
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Table 3.8: Average travel demand diversion rate for I-710 NB

Sat Sun  Avg.
ADT for regular days 50,861 57,489 54,175
ADT for construction days|38,476 36,633 37,554
r 0.76  0.64 0.69

From Fig. 3.25, Fig. 3.26 and Tab. 3.7 and Tab. 3.8, we can infer that there is a quite
substantial amount of traffic diversion in both directions, since the average daily traffic volume
during a construction weekend is only 69% of that during a regular weekend. This high diversion
rate may be due to both the flexibility of weekend traffic and the special network topology in
this project. A grid network with multiple detour routes makes it easy for travelers to choose

alternative routes to avoid potential traffic congestion.

Temporal travel demand redistribution within a day

The temporal travel demand patterns within a day are analyzed to see whether the high diversion
rate only exists during the peak time or throughout the two weekend days.

Since there are eight construction weekends and other eight regular weekends in our analy-
sis, it is difficult to determine which weekends should be picked from these two groups for com-
parison. In view of this difficulty, we first compare the temporal travel demand patterns for
construction weekends and regular weekends respectively to see whether there are significant
fluctuations in the travel demand patterns in the same group.

The I-710 SB travel demand patterns during four construction weekends with complete
traffic data are illustrated in Fig. 3.27, and those during the five regular weekends with complete
traffic data are illustrated in Fig. 3.28.
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Figure 3.27: Temporal travel demand patterns for I-710 SB during construction weekends
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Figure 3.28: Temporal travel demand patterns for I-710 SB during regular weekends

Similarly, the temporal traffic demand patterns during six construction weekends with
complete traffic data for I-710 NB are shown in Fig. 3.29, and those during the six regular
weekends with complete traffic data for I-710 NB are shown in Fig. 3.30.
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Figure 3.29: Temporal travel demand patterns for I-710 NB during construction weekends
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Figure 3.30: Temporal travel demand patterns for I-710 NB during regular weekends

As we can see from Fig. 3.27 - Fig. 3.30, the travel demand patterns for the same
group of weekends are quite consistent except the temporal travel demand patterns for I-710
NB during regular weekends. This only inconsistency may be due to the relocation of the RTMS
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in the middle of the observation period. The general consistency in the travel demand patterns
within the same group facilitates our comparison of the travel demand patterns for construction
weekends and regular weekends.

Two pairs of consecutive weekends (one for each direction) are selected as the representa-
tive weekends to compare the temporal travel demand patterns between construction weekends

and regular weekends. The comparison results are presented in Fig. 3.31 and Fig. 3.32.
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Figure 3.31: Travel demand pattern comparison for I-710 SB
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Figure 3.32: Travel demand pattern comparison for I-710 NB

As we can see from the above figures, the shape of the travel demand during construction
weekends is very similar to that during regular weekends, meaning that virtually no departure
time adjustments were made during the construction weekends. In other words, the reduction
of traffic during construction days are attributed to diversion to other routes, modes or trip
cancelations. Due to the lack of data, we cannot tell which diversion (route/mode/cancelation)
contributed most to the reduction of the total demand accessing the work zone section. Finally,
it can be seen that for both directions the demand reduction rate during peak periods is higher
than that during non-peak periods.
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3.3 A Travel Demand Diversion Model

In summary, the diversion patterns of travel demand in different construction work zone projects
can be substantially different. The I-15 freeway reconstruction project experienced only a small
travel demand reduction, and a slight departure time shift in both traveling directions. The I-710
reconstruction project, one the other hand, has seen a substantial demand reduction throughout
the whole day. The differences can be attributable to the nature of the demand (commuting vs
non-commuting), day of the week (weekday vs weekend), availability of alternative routes/modes
and traffic information, and so on.

Based on the limited observations from these two work zone projects, we now propose
an framework to characterize the diversion patterns in travel demand during the work zone
construction period. The framework is endowed with a flexible structure such that potential
factors which may have effects on traffic diversion can all be taken into account. These factors
include traffic management measures (pre-trip traveler information, media campaign, highway
advisory radio, and variable message signs) and work zone characteristics (weekday/weekend
project, daytime/night project).

In this framework, demand diversion comprises two parts: no show (trip cancelation)
and diversion to alternate routes. The no show component captures the reduction in the total
demand, i.e., travellers cancelling their trips or shifting to other modes. The route diversion

component captures users’ switching to alternative routes.!

3.3.1 No show rate
For the no show traffic, the following model will be used to calculate its rate:

0 DR € (—0,0)
NSR={ 1—aP" DR € [0,0.02] (3.1)
1— G?Rag“jsag’ampaignai\fightag[/eekend DR e (0027 +OO)

where

N SR stands for the no show rate.

DR is the delay reduction ratio calculated by DR = (Tot. delay during construction
not considering demand reduction - Tot. delay before construction) /Tot. travel time before
construction.

T1S, Campaign, Night, Weekend are binary variables characterizing factors affecting
the travel demand. More specifically,

TI1S =1 if a pre-trip traveler information system is applied, T1.S = 0 otherwise;

Campaign = 1 if a media campaign is performed and Campaign = 0 otherwise;

Night = 1 if the project is mostly performed during the night (9:00 pm - 5:00 am) and
Night = 0 otherwise;

!The changes in departure time is currently not considered but may be integrated into the framework in the
future.
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Weekend = 1 if the project is mostly performed during weekends and Weekend = 0

otherwise.

a; € (0,1] is a user specified parameter characterizing the demand reduction due to the
increase in the total delay. Namely, suppose there are no traffic management measures and the
work zone project is a daytime, weekday project, the demand during construction will be a?’#
of the original demand (for DR > 0). The higher the increase in delay, the greater demand
reduction during construction.

as, as, aq, as € (0, 1] are user specified parameters corresponding to the factors or attributes
that induce demand reduction. Namely, as corresponds to T'IS, as to Campaign, as to Night
and a; to Weekend. For example, ao = 0.9 means that the application of pre-trip traveler
information will reduce the total demand to 90% of the original demand. In addition, we
assume that these factors will have effects on the travel demand only when DR > 0.02 (this
value is subject to further calibration). In other words, if the work zone project only incurs
trivial congestion, travellers will not cancel their trips or shift to other modes. We assume that
the total effect of all the measures is the product of all the effects.

The parameters a1, as, aq, a4, a5 require to be specified by users based on past experience.
If no additional data are available, we suggest users to use 0.95 for all the parameters. Ideally
these parameters should be calibrated with field data, which requires data inputs from multiple
work zone projects.

Once the no show rate is determined, it is applied to the time-dependent demand pattern

before construction to get the time-dependent demand pattern during construction.

3.3.2 Route diversion

Route diversion can be taken care of in dynamic traffic assignment, which assigns travel demand
to the network based on some pre-assumed rules. Here we adopt the dynamic feedback traffic
assignment rule (also known as reactive traffic assignment in dynamic traffic assignment litera-
ture)?. It assumes that travelers will make en-route adjustments to their routes based on real
time traveler information. Our route diversion model assumes that the number of travelers who
make such adjustments is influenced by the traffic management measures applied. The following

model is proposed to calculate the percentage of travelers who dynamically changes their routes:
RRp = RRp + (1 — RRp)[1 — (1 — ag)Fedi°(1 — a;)VM9) (3.2)

where

RRp stands for the diversion propensity during construction and RRp stands for the diversion
ratio before construction.

Radio, VMS are binary variables characterizing factors affecting the diversion propensity.
Radio = 1 if there is a highway advisory radio broadcasting work zone traffic information

and Radio = 0 otherwise; VM S = 1 if variable message signs are installed during construction

2The details of dynamic traffic assignment will be covered in Chapter 4.
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and VMS = 0 otherwise.

ag,ay are user specified parameters characterizing the increase in the diversion propensity.
Namely, ag corresponds to Radio, and a7 to VMS. For example, ag = 0.1 means that 10%
of the original drivers who do not make enroute route adjustments will now do due to their
getting traffic information provided by the highway advisory radio. The joint effect of Radio
and VM S is characterized by 1 — (1 — ag)(1 — ary).

The parameters RRpg, ag, a7 require users’ input based on past experience. If no addi-
tional information is available, we suggest users to use RRp = 0.5,a¢6 = 0.1,a7 = 0.1 as the
default values. The calibration of these parameters requires data inputs from multiple work

zone projects.



Chapter 4

A Work Zone Traffic Analysis
Procedure

Based on the guidelines presented in Chapter 2, we now propose a comprehensive traffic impact

assessment procedure for work zones . This procedure is illustrated in Fig 4.1.

Real time traffic data (link Network
counts, link/path travel time, etc.) properties
I

Time-dependent

demand estimation Scenario data
v Traffic
Time-dependent W:)rk zcine management
travel demand ayou strategies

l Modify the scenario
Scenario traffic impact analysis (work zone schedule or
management measures )

Current scenario generates
atisfactory performance ?

No—

Yes
A 4

Select the current scenario and provide
summary statistics ; stop

Figure 4.1: A comprehensive work zone traffic impact assessment procedure

To assess a work zone’s traffic impact, the first step is to collect all the necessary data,
including real time traffic data (e.g., link counts, link/path travel times) for the work zone
area before construction, network properties, and also data defining specific scenarios. Unless
specified explicitly, a scenario here refers to the combination of the work zone construction
layout and traffic management strategies. Using network properties and real time traffic data,
we can perform an travel demand estimation to get the before-construction time-dependent

travel demand. The travel demand data, network properties, together with the scenario data

37
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serve as the basic inputs for a scenario traffic impact assessment. The scenario traffic impact
assessment is further decomposed into three steps, i.e., demand adjustment, dynamic traffic
assignment, and traffic simulation (Fig. 4.2). Demand adjustment makes a reduction of the
total travel demand to take into account canceled trips. Dynamic traffic assignment gives the
routing pattern in the network before and during construction, where travelers’ route choice is
taken care of. Finally, traffic simulation produces the required measures of effectiveness(MOE),

with which users can select the best construction/traffic management scenario.

Time-dependent
travel demand

A 4

Demand adjustment

'
Time-dependent
travel demand
during construction

»l

Network
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Scenario
data

Dynamic traffic assignment

A

/ Traffic flow pattern /

A

Traffic simulation

}

MOEs
(Total delay, travel time, maximum queue
Link specific delay , travel time, queue length, etc.)

Figure 4.2: Steps of a traffic impact assessment for a specific scenario

We now discuss in detail each step in this framework.

4.1 Data Collection

4.1.1 Scope of the work zone traffic impact assessment

The scope of traffic analysis, once defined, will help the analyst in deciding the time, manpower
and cost budget. One the other hand, the scope of analysis may be restricted by the budget.
In the latter case, the analyst may have to allocate the available time, manpower and other
resources to come out with the best solution. In any case, before embarking on full scale data
collection, the analyst should first define the scope of his analysis, i.e., the network area and the

time period in which the analysis will be performed.
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The network to be studied should not only cover the freeway mainline in which traffic
flow is directly affected by the work zone, but also contain the potential diversion routes. To
determine diversion points, it is suggested that the analyst first perform a quick D/C analysis
for the selected freeway section using its peak time demand (corresponding to the worst case
scenario, without any traffic diversion) to quickly estimate the maximum possible queue length,
and identify the segment upstream of the work zone where traffic starts to slow down. Drivers
who have experienced traffic congestion, or who can detect the queue ahead while approaching
the work zone, may choose to divert from the freeway. The starting points of diversion are the
off-ramps (including freeway to freeway connectors) right upstream of the work zone, till the
location where the maximum queue length is visible by the approaching traffic. The ending
points of diversion are the on-ramps where diverted traffic return to the freeway downstream of
the work zone. The ending points of diversion are usually fewer compared to the starting points
of diversion. Once the possible starting and end points of diversion have been identified, the
possible diversion routes can be determined. It should be noted that a transportation agency
normally demarcates only one diversion route with guide signs. Nevertheless, drivers familiar
with the local road network may choose other alternate routes. Therefore, it is recommended
that up to three diversion routes connecting the same starting and end points of diversion be
considered. The analyst should also make a quick assessment of the travel times on the possible
alternate routes to make sure that they are shorter than or comparable to that of the original
freeway route during reconstruction. Otherwise, there is no incentive for drivers to make a
diversion. Having done so, the road network to be analyzed should cover up to where the
maximum queue can be visible by travelers, the downstream returning points to the freeway,
the surrounding arterials that form the possible diversion routes, and the buffer area.

The time period of analysis refers to the duration in which traffic conditions surrounding
the work zone are to be analyzed. This time period should cover the maximum of the con-
struction schedule and the time queue is present (again this can be determined by a quick D/C
analysis). Typically, the time of interest happens in the morning and evening peak hours on
weekdays. However, in some cases, there may be prolonged hours of high traffic demand on
weekends. Although its traffic demand may not have a sharp peak like in weekdays, longer
hours of demand exceeding work zone capacity in weekends may also cause severe congestion.
The best way to decide the time period of analysis is to do a quick analysis based on PeMs
data. The volume and speed data from several loop detector stations surrounding the work zone
should be plotted against time to analyze the fluctuations within a day. Similar plots should be
repeated for several days on weekdays and weekends to establish a consistent trend, from which

the typical time period of analysis can be determined.

4.1.2 Network properties

Once the spatial scope of the network has been decided, the analyst can prepare the data describ-

ing network properties. Network properties can be categorized into link and node properties.
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Link properties include type, length, number of lanes, free flow speed, flow capacity and queue
storage space; and node properties include coordinates and type. The type of node denotes
whether a node is signalized, metered, stop-sign controlled, or with no control at all. For sig-
nalized nodes and metered nodes, initial signal timing plans and ramp metering plans must also

be provided.

4.1.3 Traffic data

Traffic data are primarily used for estimating the time-dependent travel demand when it is
not available. Traffic data that can be used in time-dependent travel demand estimation in-
clude link traffic counts (necessary), link/path travel times(optional) and historical travel de-
mand(optional). To fully capture the demand, the time period with traffic data should cover

the whole analysis period.

4.1.4 Scenario data

In most cases, the analyst may want to prepare at least one before-construction scenario and
multiple during-construction scenarios for comparison.

Before-construction scenario represents the existing traffic operations, serving as the bench-
mark for comparison with other scenarios. This scenario may also be used to calibrate the model
parameters.

For each during-construction scenario, the analyst should specify the work zone layout
including the location, capacity reduction (typically, number of lanes closed), the time period
within the analysis period when the work zone is active, and the traffic management measures
that are planned to apply, such as traveler information (media campaign, highway advisory radio,
pre-trip traveler information, variable message signs) and ramp metering. For comparison pur-
poses, the analyst may consider include a do-nothing scenario among all the during-construction
scenarios.

We summarize the required data for a work zone traffic impact assessment in Tab. 4.1.

Table 4.1: Overview of the data for a work zone traffic impact assessment
data type content

Scope of analysis |the network area, the analysis time period

Network properties|link properties: type, length, number of lanes, free flow speed, capacity,
queue storage space
node properties: type(and corresponding signal data), coordinates

Traffic data link traffic counts (necessary), link/path travel times (optional)
historical travel demand(optional)
Scenario data work zone layout: location, capacity reduction, active period

traffic management plan
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4.2 Time-dependent Travel Demand Estimation

Unlike most transportation planning applications which focus on the long-term equilibrium
traffic patterns in the network, work zone traffic impact assessment is usually interested in
the short-term, dynamic queueing process produced by the work zone construction activity.
Therefore, time-dependent rather than static travel demand data are required in such analysis.

For simple networks where most travelers enter the network from the same entry point and
leave from the same exit point, the analyst can get the time-dependent demand by counting the
time-dependent arrival flow rate at the entry point. However, reality is usually much complicated
than this ideal case. We may have multiple work zones located at different freeway segments,
and travelers enter the network at various entry points and exit from different exit points. If
the analyst can get the static travel demand data, for instance, from transportation planning
agencies by travel diary surveys, he may expand the static data to the time-dependent demand
by applying a temporal profile to it. If higher precision is required, he may rely on a time-
dependent travel demand estimator to infer the demand from traffic data such as link traffic
counts, link/path travel times, and historical demand.

Unfortunately, the time-dependent travel demand estimation methods are, to our best
knowledge, far from well developed. After a comprehensive review on the existing time-dependent
travel demand estimation methods, we recommend the logit path flow estimator (LPFE), a
method originally proposed by Bell, Shield, Busch & Kruse (1997). LPFE seeks to find the
path flow pattern that satisfies the stochastic user equilibrium condition and closely reproduce
the observed traffic counts. Originally designed to estimate steady-state travel demand, it is
extended to handle the the time-dependent case through the introduction of residual queues.
These queues are used to capture the carryover of congestion from one time period to the next.
Zhang, Nie, Shen, Recker & Chen (2006) made several extensions to the original LPFE, which
include making link travel times depend on flow through a link performance function (rather
than a constant link travel time and plus queueing delay), counting for measurement errors, and
making use of historical travel demand information. Though LPFE can only partially capture
the temporal traffic evolution, it is a quite stable, efficient, and theoretically sound method
compared to most existing travel demand estimation methods.

The time-dependent LPFE algorithm was implemented in an O-D estimation software,
Visual PFE-TD, through a Caltrans sponsored research project (Zhang et al. 2006). We shall
incorporate the same algorithm in our work zone traffic analysis tool. For completeness, we
present the formulation of the extended time-dependent LPFE. For more details of the algorithm
and its computer implementations, readers are referred to (Zhang et al. 2006).

[E-TD-LPFE]

min Z / tt (w)dw + Z ttat + (f,Infy —I) +0.5(v, D vE) (4.1)
a€Ay, acA,
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subject to

Agy < Cu—i—vfl—vfl_l (4.2)
A ft < (R I, +41) (4.3)
Aft > (LT, - o) (4.4)
Mof® < (@S, Jo + 1) (4.5)
Mof* > (G5, Jo — ) (4.6)

where

A, and A, denote the link set with and without observed flow counts, respectively.
t! (w) is the flow dependent link performance function.

x! is the volume on link a at t.

t! is the observed travel time on link a.

f; is the path flow vector for time interval ¢;

vi is the vector of queues on unobserved links at ¢.

C,, is the capacity vector of unobserved links at time t.

Ay, A, are path-link incident matrices.

M, and M, are path-OD incident matrices.

Vectors 7%, 6%, nt, ©b capture the tolerance boundaries of the measurements errors.

4.3 Scenario Traffic Impact Assessment

Once the time-dependent demand, network properties, and scenario data have been prepared,
we are ready to assess the traffic impact of different work zone scenarios. This section explains
the basic ideas in the assessment procedure. We approach this in three steps, travel demand

adjustment, dynamic traffic assignment, and traffic simulation.

4.3.1 Travel demand adjustment

The time-dependent demand we get from travel demand estimation is the demand pattern before
construction. For any during construction scenarios, this demand pattern must be adjusted to
take into account trip cancelations (no show) as a response to the work zone activity and traffic
management measures. Based on the demand diversion model we proposed in Chapter 3, we
can obtain the travel demand pattern during construction by applying a no show rate (Equation

(3.1)) to the travel demand pattern before construction.

4.3.2 Dynamic traffic assignment

The major purpose of dynamic traffic assignment is to derive the routing pattern for a given
scenario. Travelers’ route diversion behavior is also endogenously taken care of in this step.
We employ a combination of traffic assignment procedures in our analysis tool. A portion

of the trips will take the (K-)shortest paths (calculated based on free-flow travel time) regardless
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of real-time traffic conditions on the network. The remaining portion of trips will respond to
dynamic traffic conditions and pick their routes as they go. The latter is also known as reactive
or dynamic feedback assignment in transportation literature. In our tool, we implement the
following assignment procedure proposed by Kuwahara & Akamatsu (1997) to get the routing
pattern:

DYNAMIC FEEDBACK ASSIGNMENT PROCEDURE

Step0 Initialization. Set t = 0. Assume an initial network state.

Stepl Assignment. For each node ¢ leading to destination s, compute the current shortest
path from ¢ to s based on the current network state. Suppose link (7, j) lies on the shortest
path from i to s. Load all the responsive traffic at node ¢ heading for destination s at time
t onto link (7, 7). Update the network state.

Step2 Set t =t+ 1 and go back to Step 1 till the loading horizon is over.

Note that in this dynamic feedback assignment procedure, the non-responsive travelers are
assigned to the static shortest path (i.e., the shortest path calculated based on free-flow travel

time).

4.3.3 Traffic simulation

Using the routing pattern as input, we can perform a traffic simulation to obtain the needed
MOESs to compare the merits of different construction scenarios. In our tool, we make use of a
traffic simulator developed over the years by a group of researchers at UC Davis, led by Professor
Michael Zhang (see for example, Nie (2006)). Readers are referred to (Nie 2006) for a detailed
description of the traffic simulator. For completeness, we provide here only the basic properties
and fundamental ideas of this simulator.

The simulator performs dynamic network loading (DNL) in a microscopic manner, al-
though it employs a number of macroscopic traffic flow models in its core (polymorphism). Such
an approach, here we call the PDNL approach, combines the tractability and calibration ad-
vantages of macroscopic models with the capability of microscopic models to provide detailed
traffic information (such as link/route travel times for each vehicular group).

Unlike most existing DNL models which implement a specific link model and node model,
PDNL is in nature a general scheme which is capable of integrating various macroscopic link

and node models together. This polymorphism property offers the following advantages:

e Flexibility: road facilities in the same network may be represented by different models
based on various criteria, such as the tradeoff of efficiency and realism, and the character-

istics of the targeted problem.

e Extensibility: new macroscopic link/node models can be easily plugged into the framework

and compared against existing ones.
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e Parallelizability: the realization of polymorphism decouples links and nodes in network

loading, and thus opens the door to parallel computing.

Another distinct property of PDNL is its capability of tracing individual vehicular quanta.
A wvehicular quantum is an indivisible flow element which is tracked in this DNL model like a
vehicle in microscopic simulation. However the size of vehicular quanta can be set arbitrarily
small to replicate analytical results as closely as desired.

The PDNL framework implementing polymorphism is illustrated in Fig. 4.3.

| Link |
Exit Boundary
| Left tum movement |
| Entry Boundary Traffic Propagation Section == |
l |
| EE=EL . Through movement |
| e e |
| Right turn movament |
L |
r-—— " - - - - - - - —-—_ - - - - - — — — — — -
Node

MNode Models
with competition

Figure 4.3: PDNL framework

As shown, polymorphism in this DNL model is realized through interfaces that bridge links
and nodes together while maintaining their relative independence. This interface is made up of
an entry boundary(ENB) and an exit boundary(EXB) consisting of multiple movements for each
link. ENB is a fictitious element that temporarily holds the traffic flow ready to enter the link
at the current time. Conversely EXB holds all vehicles that are about to leave the link in the
next time step provided the associated node model would allow them to do so. Furthermore,
notice that EXB consists of a list of sub elements called movements, each corresponding to
a downstream link. Vehicles will be classified upon their arrival at an EXB and sent to the
movement corresponding to the next link in their journey.

Link models and node models determine how the fluxes are transferred across the interface.
Specifically, link models determine how vehicles are transferred from the link ENB to the link

EXB and node models determine how vehicles traverse from the EXB of an upstream link to
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the ENB of an downstream link.

As we can see, different node and link models may result in different fluxes that transferred
across the interface in each time interval, but the overall procedure remains the same. Links
and nodes are separated, and only communicate with associated ENBs/EXBs, the operations of
each link/node are independent of others. That is to say, various node and link modes can work
together in a network as long as they work for the interface. This is how the polymorphism is
achieved.

Now we briefly introduce how link models and node models transfer vehicles through the
interface. For illustration purposes, we use the Spatial-Queue (S-Q) model as the link model and
uncontrolled, free competition model as the node model. Note that other types of macroscopic
link and node models such as the Point-Queue model, the LWR model can also fit into the
PDNL framework in a similar way. Readers can refer to (Nie 2006) for implementation details.

The functional form of the S-Q model is as follows:

ax 0 if A\(t) =0 and u(t —m9) < C
dt { u(t —19) —C  otherwise ’ (4.7)
T(t) = 1 +)\(t+7'())/c (4.9)

where

u(t) is the entry rate at time ¢;

v(t) is the exit rate at time ¢;

A is the total number of queuing vehicle at the exit node;

7o is the free flow travel time;

C is the bottleneck capacity.

In addition, the Spatial-Queue model requires to block inflow whenever a link queue storage

space runs out, i.e,
t t
C > / u(w)dw —/ v(w)dw, vVt (4.10)
0 0

For the general uncontrolled, free competition node model, consider an intersection with
multiple incoming and outgoing links as shown in Fig. Each incoming link ; has a demand D,
and each outgoing link O; has a supply S;. For each I; the vehicle proportion heading for each
direction j, a;; are known.

We first define the virtual demands and supplies as follows:

~ S
D; = min(Di,maX(ﬁ\j =1,..,0,j #1)) (4.11)
1]

l
Si = min(Si, Z ajz-Dj) (412)
j=1

The virtual demand D; represents the maximum possible outflow rate dictated by the

standard diverse formula (one upstream link and multiple downstream links), whereas the virtual
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supply S; is the maximum possible receiving flow rate determined from a merge analysis (multiple
upstream links and one downstream link). The flux between each incoming-outgoing link pari
17 can then be computed by the following formula

> k=1 Drak;

Note that this general uncontrolled, free competition node model is consistent with the

) (4.13)

Uij = min(Diaij,

standard merge and diverge models by (Zhang et al. 2006).

We are now ready to present how this link and node models can be discretized and fit
into the PDNL framework. Suppose we use ¢; as the length of each time step. Traffic flow
is measured in the unit of vehicular quantum. A vehicular quantum is similar to an individual
vehicle except that a quantum may carry an arbitrary amount of traffic flow. Usually we assume
that each vehicular quantum should carry the identical amount of traffic, denoted by dy.

Each link is divided into L — 1 cells, with an identical length

d0x = sp¢y (4.14)
where s; is the free-flow speed. The number of cells L is calculated by
L = [dist/dx]— (4.15)

where dist is the link length and [a]- = argmax{i < z,i € Z}. The EXB element is also a cell
with a length dx; = dist — (L — 1)éx > dx. The number of vehicular quanta in each cell i is
denoted by [/;. In an EXB, vehicular quanta are classified by movements. Let I7' denote the

number of quanta in movement m, we have

M
dip=1g (4.16)
m=1

where M is the total number of movements in the EXB.
For the S-Q model, the following algorithm is used to transfer flows from ENB to EXB

for each time tick.

FPP-BOTTLENECK

Step0 Update [;(t +1) = l;_1(t),i = 1,...,L — 1. Update two boundaries with lo(t + 1) = 0,
Ip(t+1) =1(t) +1p-1(t).

Stepl Move I1_1(t) vehicular quanta from ENB to EXB.

We now discretize node models, which carry traffic from upstream EXBs to downstream
ENBs. Consider an intersection with n approaches. Each approach ¢ has an incoming and
outgoing link denoted by I; and O;, respectively. Let l;;(t) be the number of quanta in EXB of
approach i at ¢, and l,;(t) be the number of quanta in ENB of approach i at ¢t. Further, lfz(t)
is the number of quanta in EXB of approach i heading for the approach j. The discrete flow

propagation procedure reads
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FPP-NoODE

Step0 Calculate the turning proportion in each EXB using the following

(1)
Lii(t)

Calculate the demand D; for each EXB of approach ¢ and supply S; for each downstream

ai; =

link of approach 4. This largely depends on the characteristic of link models.
Stepl Calculate fluxes v;;. Transform v;; into number of quanta n;;, i.e., n;; = [%f]r 1

Step2 Update IZ;(t + 1) = I2,(t) — nj, Vi, j, and loj(t + 1) = 327 nyj, V.

7

Step3 Move n;j vehicular quanta from EXB of approach ¢ into ENB of approach j.

We are now ready to summarize the PDNL procedure. The network is assumed to be empty
at the start. In each time step ¢, the first operation is to release new vehicular quanta from
origins based on the time-dependent travel demand pattern. Then a preprocess to propagate
flow is followed. Capacity reduction due to work zone projects, for example, can be taken into
account at this step. The procedure is terminated when the network clears out (all released
vehicles have reached their destinations).

The main task of PDNL is to sequentially process nodes and links to propagate vehicular
quanta. Whenever a link FPP is called, the cumulative traffic counts up to ¢ are recorded.
Further, all quanta entering the ENB of a dummy destination link at ¢ will be labeled as
7arrived” and thereby removed from the network.

Once we get the link cumulative curves, we can calculate various MOEs such as time-
dependent link travel time, link volume, queue length and link /node delay.

This concludes our presentation of the traffic analysis procedure for work zones.

where € is a U(0, 1) random variable.



Chapter 5

NetZone - A Work Zone Traffic
Analysis Tool

The work zone traffic impact assessment procedure described in Chapter 4 is implemented into
a software package called NetZone. It assembles a number of dynamic traffic analysis methods
which aid users to perform a quick yet detailed analysis of work zone traffic impact. This chapter

introduces the key features of NetZone.

5.1 An Overview of NetZone

Fig. 5.1 illustrates the basic implementation structure of NetZone. As shown, NetZone makes
use of two major C++ dlls (tnm.dll and mat.dll) developed over several years by Professor
Michael Zhang’s research group. tnm.dll defines hierarchical network objects including nodes,
links, vehicles, ODs, work zones, etc., and implements basic network operations such as shortest
path searching, network construction, etc.; and mat.dll implements various types of iterative
algorithms for both general and network-specific purposes. A graphical user interface (GUI) for
NetZone is developed based on these two C++ dlls utilizing Microsoft Foundation Classes(MFC),
to provide users with a convenient visual environment for performing all the work zone traffic

impact assessment operations.

Database related functions

(MYSQL)
¥
ToolKit of Network Modeling (TNM) Library Mathmatical lterative Algorithms (MAT) Library
defining hierachical network objects Implementing algorithms such as OD
(C++ DLL) estimation, DTA, etc. (C++ DLL)

v
Graphic User Interface
(Developed by MFC )

Figure 5.1: The implementation structure of NetZone
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5.2 Key Features of NetZone

NetZone is designed to help transportation professionals estimate network wide traffic impact of
construction work zones under different traffic management strategies, and facilitate the design
of efficient construction and traffic management plans. Unlike previous work zone traffic impact
assessment tools such as the Highway Capacity Software or QuickZone, which only provides
estimates of queues upstream of the work zone, NetZone is a network analysis tool capable of
estimating the network wide traffic impact for different types of networks. While many of the
features in NetZone, such as its demand diversion models and assignment rules, specifically
address work zone related issues, NetZone can also be adapted to become a general corridor
traffic analysis tool for for planning and/or traffic operation applications.

The key features of NetZone are summarized as follows:

5.2.1 Detailed representation of networks

NetZone is designed for general networks of any topological types, hence can be used to model
both freeway and urban networks. The details of each element in a transportation network,
including links and their properties, intersections and their control types, origins and destinations

are all modeled in NetZone.

5.2.2 Traffic control

Both signalized control and ramp metering can be modeled in NetZone. The basic functions
of pre-timed and traffic responsive control are implemented for both control types. The traffic

responsive ramp metering logic adopts ALINEA.

5.2.3 State-of-the-art simulation and assignment models

NetZone embeds a state-of-the-art traffic simulator which is polymorphic and hybrid. It is
polymorphic in the sense that different links can be modeled by different types of traffic flow
models, depending on the details one wish to achieve. For example, if the user is only interested
in how the queue propagates along the freeway, he can set the types of freeway links as a
LWR link while other links as either P-Q links or S-Q links. It is hybrid in the sense that it
moves vehicular quanta individually according to macroscopic traffic flow relations. Macroscopic
models capture the essence of traffic propagation in the network, but are much easier to calibrate
than their microscopic counterparts owing to their limited number of physically meaningful
model parameters.

NetZone implements a hybrid traffic assignment procedure. A portion of the trips (non-
responsive traffic) will take the (K-)shortest paths (calculated based on free-flow travel time)
regardless of real-time traffic conditions on the network, while the remaining portion of trips

(responsive traffic) will respond to dynamic traffic conditions and pick their routes as they go.
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Users have the flexibility to choose the portions of responsive and non-responsive traffic in the

network so as to achieve a desired distribution of traffic in the network.

5.2.4 Demand diversion model

In NetZone, a demand diversion model which estimates the reduction in total demand, and the
diversion to other routes due to the construction work is developed based on data from multiple
work zone projects in California. The effects of induced delay, work zone properties, and traffic
management measures are taken into account in this model. When data are not available to
calibrate the parameters of the diversion model, NetZone also provide the user the option to

specify demand reduction rates based on his judgement.

5.2.5 Multiple options in each step

NetZone is very flexible. It provides multiple options in nearly every step of the analysis, from
input preparation to MOE generation. This flexibility allows users to choose the option they
are most familiar with or have readily available data. It also enables users to balance the
computational overhead and the solution quality, based on their specific purposes. Table 5.1

summarizes some of these options.

Table 5.1: Options available in NetZone
Step option
Set up the network Constructed directly in NetZone
Imported (from Dynasmart-P, from ESRI .shp, from FORT)
Prepare the time-dependent demand | Synthesized from static demand
Estimated based on traffic data (e.g. link counts, path travel time, et
Imported from an external pre-prepared demand file
Configure the work zone layout Set up directly in NetZone
Imported from an external pre-prepared configuration file

5.2.6 Detailed outputs and statistics

NetZone provides detailed outputs and statistics at both aggregate and the disaggregate levels.
During the simulation, users can see the changes in speed/delay/density on each link in the entire
network, or zoom in to a particular link to see how congestion builds up and dissipates along
it. When the simulation is completed, a detailed report is generated summarizing the aggregate
statistics for the whole network as well as each OD pair, such as the total travel distance, total
travel delay, average travel speed, average travel time, average travel delay, longest travel delay,
maximum queue length, etc. Users can also view various plots for link specific cumulative flow

curves, delay, volume, travel time, speed, in-out flow, and density contour.
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5.2.7 Graphical User Interface(GUI)

NetZone implements a GUI (Fig. 5.2) that allows users to easily perform different types of
operations, such as preparing, modifying and viewing inputs and outputs. The graphical user
interface is designed to work under Windows XP, NT and 2000 platforms.
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Figure 5.2: The NetZone GUI

The NetZone GUI is made up of three parts: the main menu, the tool bar and the network
display/editing area. The main menu and tool bar integrate most of the analysis functions, and
the network display/editing area shows the network topology and traffic simulation results. The
menu bar of NetZone consists of ten pull-down menu items: Project, Network, Edit, TD-Demand,
WorkZone, Simulation, Evaluation, View, Tools, Help, arranged approximately in the sequence of
carrying out a work zone traffic analysis. The basic function of each menu items are listed in
Table 5.2.
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Table 5.2: NetZone menu items and their functions
Menu item |function

Projects Defines a project and specifies project settings
Network Provides the means to construct a network
Edit Integrates a variety of network editing commands

TD-Demand | Estimates time-dependent OD trip tables

WorkZone | Defines the work zone layout and associated traffic management plan
Simulation |Contains the simulation related commands

Evaluation |Compares the MOEs of different scenarios

View Allows users to check the major input data files
Tools Provides a number of useful commands to facilitate analysis
Help Provides help information for NetZone

A detailed description of the menu commands of NetZone is presented in NetZone's user

manual, and not repeated here.

5.3 The Workflow of NetZone and a Quick Tutorial

In NetZone, each study is organized as a Project. A NetZone project combines all the data,
including network, travel demand, work zone layout, traffic management plans, assignment
pattern, simulation results and all the intermediate data. Once a project is created, NetZone
will automatically create a folder with the assigned project name under a specified path. All
the data associated with the project will be placed in this folder.

The basic inputs for a NetZone project include network characteristics, traffic control
plans, and time-dependent OD information.

In one project, multiple Scenarios can be created, each corresponding to a different work
zone layout and traffic management setting. The scenario-specific inputs include the work zone
layout and the adopted traffic management plan. NetZone stores the simulation results for
different scenarios under their respective scenario names. Users can load these results to compare
and select the best alternative.

Fig. 5.3 illustrates the work flow of using NetZone to perform a work zone traffic analysis
task.
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Figure 5.3: The work flow in NetZone

The rest of this section provides a quick tutorial to NetZone. Using a demonstration
example, we show how to create a project from scratch in NetZone, how to prepare the relevant
inputs, how to design scenarios, and how to evaluate and compare scenarios. The demonstration
example is designed in such a way that most important functions of NetZone are covered. Users
are highly recommended to go through this demonstration example step by step to get familiar
with various commands in NetZone before conducting a work zone traffic impact study.

The demonstration example is based on an artificial network with 15 links, 10 nodes
(one of which is a pre-time signalized intersection), and six OD pairs, covering a stretch of
freeway and two arterial routes as detour routes (Fig. 5.4). Pavement maintenance work will
be performed on a freeway segment during the morning peak time of a weekday. The work zone

traffic impact assessment is conducted to examine 1) whether the construction work will cause
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severe congestion in the network; 2) whether it is necessary to apply specific management plans
to alleviate the induced congestion; 3) how the mitigation effects of different management plans
are. The data files required to set up the demonstration example are placed in the installation
directory (...\NetZone\projects\Demo\Input). A finished copy of the demonstration example is
also included (...\NetZone\projects\Demo\demo_finished.prj).
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Figure 5.4: The demonstration example

When describing the traffic impact assessment procedure in this tutorial, we mainly focus
on articulating the sequence of the steps and how to make use of the commands to carry out each
step. The detailed operations within each command are not described or only briefly mentioned.
Users can refer to the user’s manual for a comprehensive description of each command.

We assume that the NetZone program has been launched before setting up the demon-
stration example.

5.3.1 Step 1: Create a project

Select the Project->New menu command. In the Create a new NetZone project dialog popped
up, specify the project name as Demo and save it in the default directory. NetZone will create
an initial project for users.

Next, to specify the basic project settings, click the Project->Settings menu command
to launch the Settings dialog. In this example, we choose the starting time of analysis to be
Oct. 7, 2006 6:00 am and the end time of analysis to be Oct. 7, 2006, 9:00 am. The end
traffic measurement time is set as Oct. 7, 2006 9:30 am. The demand/measurement interval
is 60 seconds. The simulation interval is five seconds and the flow resolution is one vehicle per
flow unit. The algorithm parameters are set as follows: maximum iteration - 60, convergence

criterion - 0.001, and desirable objective function value - 0.001.
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5.3.2 Step 2: Set up the network

Use menu commands Edit->Node, Edit->Link, and commands Add a node, Add an outbound link,
Add an outbound pair from the right-button menu to construct the demonstration network (Fig.
5.5). All the nodes except node 2 are specified as FIFO freeway junctions and node 2 is specified

as a Pre-time control node. The link properties are listed in Table 5.3.

0@
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(11282, 7569) Origin: NjA Dest: HfA Edit Workzons UM

Figure 5.5: The sample network

Table 5.3: Link properties for the sample network

ID Type From To Length Free flow speed Capacity queue storage Lane
(m) ) () (v/m)
1 LWRLK 1 2 5 60 1800 180 4
2 LWRLK 2 3 5 60 1800 180 4
3 LWRLK 3 4 8 60 1800 180 4
4 TWRLK 4 5 10 60 1800 180 4
5 LWRLK 6 2 5 30 1500 180 3
6 LWRLK 2 7 1 30 1500 180 2
7 LWRLK 7 8 15 30 1500 180 1
8§ LWRLK 5 8 1 30 1500 180 2
9 LWRLK 3 9 1 30 1500 180 2
10 LWRLK 9 10 10 30 1500 180 1
11 LWRLK 5 10 1 30 1500 180 2

Then specify the O-D pairs. By right clicking a node and selecting the Attach origin or
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Attach destination command from the pop-up menu, we can add origin/destination nodes and
associated dummy links to the network. Each ordinary node can at most attach one origin node
and one destination node. In this example, two origins 11 and 12 are attached to nodes 1 and 16
respectively, and three destinations 13, 14, 15 are attached to nodes 5, 8, 10 respectively. The

network with origins and destinations added is shown in Fig. 5.6.

Ok
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Figure 5.6: The sample network with origins and destinations

5.3.3 Step 3: Specify the traffic control settings

Use the Edit->Signal->Initialize menu command to enable signal editing functions. Then right
click node 2 and select the Set signal command from the pop-up menu. In the Set signal dialog
pop-up menu, we can see that the program has already generated a default signal timing plan,
which contains two phases (30s each) in every cycle (60s). Each phase has two movements.
Change the duration time of phase 1 from 30s to 40s. The cycle length is now 70s.

The signal timing plan for node 2 is summarized in Table 5.4.

Table 5.4: Signal timing plan for node 2
Phase length movements
I 40 s link 1 to link 2(through), link 1 to link 6 (left turn)
IT 30 s link 5 to link 2(right turn), link 5 to link 6 (through)
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5.3.4 Step 4: Prepare time-dependent demand

First, construct the origin-destination relationships. To do so, select the TD-Demand menu
command to launch the OD Editor dialog box. In the launched O-D Editor dialog box, add the
six OD pairs and their corresponding total demand (Tab. 5.5).

Table 5.5: Total demand for each OD pair in the sample network

Origin ID Destination ID Demand
11 13 2940
11 14 2940
11 15 3240
12 13 1800
12 14 2850
12 15 1080

There are three ways to prepare the travel demand, i.e., synthesizing one from a static
demand table, estimating one from link traffic counts, and importing one from other sources.
In this example, we use the first method to get the OD pattern and then directly modify the
demand file to get the time-dependent demand we wanted.

Select the TD-Demand->Synthesize->Generate command to specify a trapezoid demand
pattern. We then directly modify some entries of the O-D trip tables by using the View->Network
file->Dynamic OD menu command to open the demand file. Be aware that this demand mod-
ification will only take effect the next time you open the project. The final time-dependent

demand pattern we use in this sample network is shown in Table 5.6.
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Table 5.6: Time-dependent OD demand
OD pair 11-13 OD pair 11-14 OD pair 11-15
5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 6 6 6 6 6 6 6 6
5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 6 6 6 6 6 6 6 6
5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 6 6 6 6 6 6 6 6
5 5 5 5 5 5 20 20 5 5 5 5 5 5 20 20 6 6 6 6 6 6 12 12
20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 12 12 12 12 12 12 12 12
20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 12 12 12 12 12 24 24 24
20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 24 24 24 24 24 24 24 24
20 20 20 20 24 24 24 24 20 20 20 20 24 24 24 24 24 24 24 24 30 30 30 30
24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 30 30 30 30 30 30 30 30
24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 30 30 30 30 30 30 30 30
24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 30 30 30 30 30 30 30 30
24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 30 30 30 30 30 30 30 30
24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 30 30 30 30 30 30 30 30
24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 30 30 30 30 30 30 30 30
24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 24 30 30 30 30 30 30 30 30
20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 24 24 24 24 24 24 24 24
20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 24 24 24 24 24 24 24 12
20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 12 12 12 12 12 12 12 12
20 20 20 20 20 20 5 5 20 20 20 20 20 20 5 5 12 12 12 12 12 12 6 6
5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 6 6 6 6 6 6 6 6
5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 6 6 6 6 6 6 6 6
5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 6 6 6 6 6 6 6 6
5 5 5 5 5 5 5 5 6 6 6 6
OD pair 12-13 OD pair 12-14 OD pair 12-15

6 6 6 6 6 6 6 6 10 10 10 10 10 10 10 10 6 6 6 6 6 6 6 6
6 6 6 6 6 6 6 6 10 10 10 10 10 10 10 10 6 6 6 6 6 6 6 6
6 6 6 6 6 6 6 6 10 10 10 10 10 10 10 10 6 6 6 6 6 6 6 6
6 6 6 6 6 6 12 12 10 10 10 10 10 10 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 30 30 30 30 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 30 30 30 30 30 30 30 30 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 30 30 30 30 30 30 30 30 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 30 30 30 30 30 30 30 30 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 30 30 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 12 12 15 15 15 15 15 15 15 15 6 6 6 6 6 6 6 6
12 12 12 12 12 12 6 6 15 15 15 15 15 15 10 10 6 6 6 6 6 6 6 6
6 6 6 6 6 6 6 6 10 10 10 10 10 10 10 10 6 6 6 6 6 6 6 6
6 6 6 6 6 6 6 6 10 10 10 10 10 10 10 10 6 6 6 6 6 6 6 6
6 6 6 6 6 6 6 6 10 10 10 10 10 10 10 10 6 6 6 6 6 6 6 6
6 6 6 6 10 10 10 10 6 6 6 6
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A copy of this demand pattern is stored in ...\NetZone\projects\Demo\ Input\tdemand.btd.

Users can also use the TD-Demand->Import menu command to import this demand pattern.

5.3.5 Step 5: Create various project scenarios

So far we have gathered all the basic data needed for the work zone traffic impact assessment.
The next step is to create various project scenarios for analysis. In this demonstration example,

the following four scenarios are generated, and their MOEs compared.

Table 5.7: Scenario description

Scenario Description
I Before construction
11 During construction, no specific traffic management plan is used (do nothing)
111 During construction, pre-trip traveler information is applied
v During construction, pre-trip traveler information and
media campaign are applied

5.3.6 Step 6: Scenarios evaluation

Evaluate Scenario I: Before construction

First, make sure that the WorkZone->Activate WorkZone command is NOT checked. Then
use the Simulation->Run menu command to perform the traffic simulation. In the TNM-Traffic
Simulation dialog popped up, click the Start button to initiate the simulation. You can also check
the Dynamic visualization checkbox so that you can monitor the change of the general statistics,
i.e, the number of enroute vehicles, moving vehicles, and queued vehicles in the dialog. Once
the simulation is finished, click the Close button to exit from the simulation dialog box. Name
the scenario as SI_Before.

Now you may consider to use the Simulation->Replay command to get an visual inspection
of how network traffic conditions change during the whole study period and monitor the traffic
evolution on certain critical links at the same time. To do that, check the View->Map Window-
>Density option. When the simulation is being replayed, different colors will represent different
levels of density, which indicates the level of congestion. To get a good display resolution,
double click any blank area of the working space to launch the Set display properties dialog, and
check the Show cell boundary checkbox in it. Since link 3 will be the potential congested link
when the construction work is performed, we may want to check the traffic conditions of link 3
before construction. To achieve this, right click link 3 and select Dynamics->Density animation.
This will launch an empty Dynamic density animation dialog with both critical density and jam
density marked. When the simulation is performed, the density fluctuations along link 3 will be
displayed in that dialog box.

Select the Simulation->Replay menu command. This will launch the Replay simulation slide
bar. Now click the Play button. Pay attention to the color changes. Click the Stop button once
the replaying process is finished. Figure 5.7 is a snapshot of the replay process.
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Figure 5.7: A snapshot of replaying simulation

As you might have noticed, except for some minor queuing occurring right before the
signalized intersection, there is no severe congestion in the network before construction. You
may also store the density contour of link 3 for future use. To do that, right click link 3 and select
Dynamics->Density contour from the pop-up menu. Once the density contour plot is shown, right
click the plot and select Save PGL figure from the pop-up menu. The figure is then saved.

Once the scenario is evaluated and the corresponding results are generated, select the

Simulation->Clear menu command to clear the simulation results.

Evaluate Scenario II: do nothing

First select the WorkZone->Configuration menu command to specify the work zone layout. Doing
so will launch the work zone configuration dialog bar at the bottom of the working space. On the
Basic sheet on the left, name the work zone project as CA_WorkZone_example, and check both
the Weekend and Day work radio button. The traffic management measures will be specified
later.

Add link 3 and link 4 into the work zone link list. The work zone layout information is
listed in Table 5.8.
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Table 5.8: Work zone layout

Link Start Time End Time Start Location End Location Cap. Reduction Cap. after reduction
(m) (1) (%) (veh/hr)
3 06:30 am 08:00 2 8 75% 1800
4 06:30 am 08:00 0 2 75% 1800

A copy of this work zone layout is stored in ...\NetZone\ projects\ Demo\ Input\WorkZone.wbc.
Users can also use the WorkZone->Import menu command to import the data.

Select the WorkZone->Show WorkZone Locations menu command. The work zone links we
just specified will be highlighted (Fig. 5.8).
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Figure 5.8: The sample network with work zone

Check the WorkZone->Activate WorkZone menu command. Next, we determine the travel
behavioral factors. Select the WorkZone->Behavior Factors menu command to launch the Be-
havior factors dialog. In this example, we ask the demand adjustment model to calculate the
no-show rate. Check the Calculate by Model checkbox. Since no traffic management measures
are applied in this scenario, we only need to specify the delay factor which takes account of
the demand reduction due to the increase of delay and the weekend factor which considers the
demand reduction in a weekend closure. The default value for both factors is 0.95. Click the
Calculate button. Once the calculation is done, the no-show rate will be updated. In this case,

the no-show rate is roughly 0.101, meaning that 10.1% of the travelers will cancel their trips or
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shift to other modes.

Now exit from the Behavior factor dialog by clicking the OK button. Traffic simulation can
now be performed as what was done for the before construction scenario. Name the simulation
result as SI:During.

Similar as in scenario I, you can replay the simulation to view the changes of traffic
conditions for the entire network or specific links over time. If you do so, you’ll notice that due
to the construction work, traffic queues right upstream of the work zone, and some travelers
take the two arterial routes for diversion and cause some extra congestion on those links. Fig.

5.9 shows a snapshot of the density in the network at time 7:40 am.
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Figure 5.9: A snapshot of the network-wide density for scenario I1

You may also consider saving the density contour of link 3 for future use.

The steps to run scenarios III and IV are similar to those of scenario II, except that
at the very beginning users should first select the corresponding traffic management plan and
recalculate the behavioral factors. For example, for scenario III, you should first launch the
WorkZone configuration dialog bar. Click the Management property sheet, and check the Pre-trip

traveler information system option, and then recalculate the behavior factors.

5.3.7 Step 7: Scenario comparison

Once the MOEs for all the scenarios have been generated, we can now compare them. To do
that, Select the Evaluation->Overview menu command. In the General statistics dialog box, load
all the four scenarios and all the links. The general statistics of all the four scenarios are depicted
in Fig. 5.10.



CHAPTER 5. NETZONE - A WORK ZONE TRAFFIC ANALYSIS TOOL 63

Scenarios Select links
Avalalable scenarios Availablz inks Selected inks ose |

o | Type | Startnods | Endrode | o | Tvpe | Startnode| Endrode| A
1 LwRLK 1 2
2 LRLE
o 3 Lu/RLE
%+ Lw'RLE
5 LWRLE
6 LW/RLE
7
8

LWRLE
LWRLE

Delte |

Delete Al 9 LWRLE
—_— 10 LWwRLE
11 LWRLE

add | addal | Delese | Deleteal 12 oMo

Statistics

Scenaria | Tot. cost thr) | Tot. delay (hr) | Avg. costihr) | Avg. delay (hr) | Max, delay (D) ... | MDIinkID | MDtme | Max queueiveh) | mounkm | motme |
S1_BEFORE 7323.9365 419.0528 0.0828 0047 0.1750 07:29:45 335.0000 5 07:40:50
SII_DURING B357.2100 555.8764 0.0954 0.0083 0.2153 3 07:44:50 &02.0000 3 08:05:45
SIII_DURIMNG 5003.4541 263.3208 0.0908 0.0048 0.1028 3 07:02:50 261.0000 3 08:05:45
SIv_DURING 4757.0195 264.5861 0.0904 0.0050 0.10863 3 07:46:35 2640000 3 08:05:40

BB woounmaw

e R s R NP

Figure 5.10: Scenario comparison: general statistics

As we can see from Fig. 5.10, the construction work in this example does create sub-
stantial congestion in the network. The total delay in scenario II (construction with no traffic
management measures) is about 32% larger than that in scenario I (before construction). The
maximum queue happens on link 3 at time 7:44:50 am, with about 600 vehicles. The maximum
delay is about 13 min. The improvement in traffic conditions due to active management is also
significant. By providing pre-trip traveler information, the total delay in scenario III is even
lower than that in scenario I (the potential delay scared off more travelers than needed to keep
traffic conditions no worse than before construction began) and there is no significant delay on
the freeway. However, the difference between scenario III and IV are trivial. In this hypothetical
example, the analysis shows that pre-trip information should be provided and once this is done,
the traffic during construction will experience no additional delay.

We can also use the Evaluation->Link specifics menu to compare the traffic conditions on
specific links under different construction and traffic management scenarios. In this example,
users may especially be interested in the delay on link 3 (which contains the work zone) and
also the delay on link 6 and link 9, which are the links on possible diversion routes. Fig. 5.11
show the results provided by the dialog Link Specifics.
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In this small example, we demonstrated some of the most basic features of NetZone and
how to use them to compare and select the best construction/traffic management scenario.

NetZone also provides many advanced features such as generating density /speed contour plots
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for a link or route. And for these functions and other details, the reader is referred to the

NetZone User Manual.



Chapter 6

A Case Study

This chapter presents a case study, in which NetZone is used to assess the traffic impact of a
hypothetical construction in a real corridor network. The case study serves several purposes, one
is to demonstrate the capabilities of NetZone in dealing with realistic sized problems, another is
to evaluate its computational efficiency and effectiveness of NetZone, and last but not least, still
another is to identify and address potential problems in NetZone. All the computations in this
case study are performed on a Windows-XP PC with two x 3.0 GHz CPU and 4 GB memory.

6.1 Network Description

The SR-41 corridor network in Fresno, California is used for this case study. The corridor
contains the SR-41 freeway and the arterial roads on both sides (Fig. 6.1). In this network,
there are nine interchanges connecting the SR-41 freeway with the arterial roads.

Caltrans district personnel collected detailed link traffic counts for this network and also
coded the network in Paramics. We converted the original network in Paramics to NetZone (Fig.
6.2). The link traffic counts are also imported into NetZone for travel demand estimation. Since
there is no construction activity during the time period when the traffic data were collected, a
hypothetical work zone is introduced on the SR41 freeway. In this case study, we use NetZone to
perform a work zone traffic impact study on this network to see how the work zone project affects
the traffic conditions on both the freeway and the surrounding arterial roads. In addition, we

would also like to see how traffic management measures can be used to relieve traffic congestion.

The SR41 Fresno corridor network in NetZone contains 1365 nodes, 2090 links, 174 origins
and 168 destinations. The total number of OD pairs is 7110. There are 83 signalized intersections

on the arterial roads and 16 ramp meters.

6.2 Create Analysis Scenarios

The hypothetical construction work activity is assumed to start at 3:35 pm and end at 4:35 pm
on Feb. 2, 2005. The work zone is assumed to be 0.437 miles long, covering link 10 and link 115

66
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Figure 6.2: The SR41 Fresno network in Net-
Figure 6.1: The SR41Fresno Zone

(Fig. 6.3). Two of the three lanes is assumed closed for construction work. Meanwhile, during
the construction, it is assumed that the on-ramp right upstream of the work zone is closed to

traffic.
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Figure 6.3: Hypothetical work zone in SR41Fresno corridor

The following three scenarios are generated and compared: scenario I: Before construction;
scenario II: During construction, do nothing; scenario III: During construction, with pre-trip
traveler information and media campaign.

In NetZone, the study horizon is defined as 3:30 pm - 5:00 pm. The demand interval is set
as 15 min and the simulation interval is set as 2 seconds. All travelers are assumed to respond

to pre-trip and real-time traveler information.

6.3 The Analysis Results
6.3.1 Time-dependent OD demand

For this case study, LPFE is used to estimate the time-dependent OD demand based on observed
link traffic counts and historical time-dependent demand data. The estimation takes roughly
one minute. Fig. 6.4 and 6.5 depict the estimated total link counts and observed total link

counts.
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Figure 6.4: Comparison of the observed and estimated link traffic counts
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Figure 6.5: Deviation from the observed link traffic counts

As we can see from the above figures, the estimated O-D demands are generally consistent
with the observed values. To further examine whether the estimated results can capture the
temporal distribution of demand, we also compared the estimated and observed link flows for
every 15 mins. Eight links, four on the SR41 freeway and four on arterial roads are selected for

this comparison.
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As can be seen from Fig. 6.6 and Fig. 6.7, the estimated link traffic counts, especially

the freeway counts, match the observed values quite well. The temporal fluctuation of traffic
flows on arterial roads are not very well captured. This may be due to two factors: the lack of

sufficient observations on arterial roads and the presence of more paths on arterial roads.

6.3.2 General results

Applying the demand diversion model, we get the no-show rates for scenarios II and III, which
are 0.1% and 3.11% respectively. Performing simulation for all the three scenarios, we get the
following general statistics (Table 6.1).

Table 6.1: General statistics for all the three scenarios

Scenario Total cost Total delay Avg. cost Max. delay(MD)
(hr) (hr) (hr) (hr)
I 11560 3796 0.0049 0.1783
11 13303 5232 0.0054 0.9083
11T 12378 4659 0.0052 0.9156

As can be seen from Table 6.1, the presence of the work zone project increases the total
delay by 37.8% and the maximum link delay by 409%. By applying pre-trip traveler information
and a media campaign, the induced delay can be reduced by 15.1%, but no significant reduction

in maximum link delay is observed.

6.3.3 Link/Path specific results

To examine the traffic conditions on the freeway in detail, we compare the queueing pattern on
SR41 upstream of the construction work zone in (Fig. 6.8).

According to Fig. 6.8, there is no substantial congestion on this freeway segment before
construction. During construction, if no traffic management measures are implemented, traffic
congestion will develop from two locations: right upstream of the work zone (link 10) and the
upstream link of the last off-ramp upstream of the work zone. The queue developing from link
10 spills back to link 614 and link 612. Traffic congestion develops at the latter location because
the demand wish to exit from the off-ramp exceeds its capacity.

When traffic management measures, i.e., pre-trip traveler information and media cam-
paign, are applied, the congestion pattern at this freeway segment is similar to scenario II, but
the severity of congestion is reduced. For example, the queue developing from link 10 now only
spills back to link 614, but not to link 612.

We now further examine the flow characteristics on link 10. The link specific cumulative
arrival and departure curves, travel time and speed plots for link 10 are shown in Figure 6.9.

According to Fig. 6.9, the total number of travelers using the SR41 freeway has decreased

due to the construction work. In addition, the travel time on this link is increased from about 30
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Figure 6.8: Comparison of the density contour on SR41 freeway

seconds to about 200 seconds, a nearly 700% increase. The average speed during construction
drops to about 10 miles/hour.

Next we look at the traffic conditions on arterial roads to see how traffic diversion affects
arterial traffic. We first plot the cumulated arrival/depature curves through the off-ramp (link
611) right upstream of the construction work zone (Fig. 6.10).

According to Fig. 6.10, during construction, the total number of vehicles taking this off-
ramp almost doubles the volume before. The number of diverted vehicle in Scenario III is less
than that in Scenario II, probably because the total demand is reduced. To further verify this
diversion, we also plot the cumulated flow on arterial links (link 2272 and link 2160) close to
the construction work zone (Fig. 6.11).

As expected, the total number of vehicles using arterial roads is higher for the two during
construction scenarios than the before construction scenario. One thing worth noticing is that

in Scenario II, the diverted traffic actually causes extra delays on the arterial links (the red
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Figure 6.9: Flow characteristics of link 10

area in Fig. 6.11). In Scenario III, because of the total demand reduction due to the traffic

management measures, the induced delay on arterial roads is eliminated.

6.3.4 Summary

Based on our analysis above, we can see that the hypothetical work zone project does cause
substantial congestion in both the SR41 freeway and the arterial roads if one does not imple-
ment any traffic management measures. Queues on the freeway develop at two locations, right
upstream of the work zone and the upstream link of the last off-ramp upstream of the work
zone. If pre-trip traveler information and media campaign are applied, the total delay in the
network can be reduced significantly. The congestion on the freeway is partially alleviated and
the induced delay on arterial roads can be mostly eliminated. From the results produced by
NetZone, we conclude that pre-trip travel information and a media campaign is adequate to
bring traffic congestion to a tolerable level in this hypothetical case.

With this case study, we demonstrated that NetZone can be used to study the traffic
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Figure 6.11: Comparison of the cumulative flows on arterial links

impact of a construction work zone in a real size corridor network with a reasonable amount of
effort. Compared with a similar study performed with a microscopic simulation (the I-15 Devore
project), we used less than one tenth of the developmental time to do this study, a significant

time saving.



Chapter 7

Conclusions

The main goal of this project is to develop a general purpose traffic analysis tool for construc-
tion work zones. To accomplish this, we first reviewed the current practices in work zone traffic
management on several aspects, including methods used, data needs, reliability, ease of use, user
satisfaction, and limitations in assumptions. We also identified the gaps between the current
practices and the best possible practice that can be achieved with the latest Intelligent Trans-
portation Systems (ITS) technology. Next, we analyzed construction work zone traffic data to
study demand diversions under various active traffic management measures, and proposed a
preliminary demand diversion model to capture the no-show demand reduction caused by work
zones. Then, we proposed a systematic work zone traffic analysis procedure for quickly assess-
ing network-wide traffic impact of a given construction plan. This procedure includes demand
preparation, dynamic traffic assignment, macroscopic traffic simulation, and scenario analysis.
last but not least, we implemented the proposed procedure into a user-friendly software tool,
NetZone, and evaluated the NetZone tool in a case study with a large size corridor network, and
prepared a user manual for NetZone. This report documented the main accomplishments and
key findings.

In Chapter 2, we conducted a systematic review of current CWZ traffic analysis tools and
identified four types of tools often used in work zone traffic analysis: queue-based tools (e.g.,
Demand/Capacity and QuickZone), transportation planning models (e.g., TP+, EMME/2),
macroscopic freeway simulation models (e.g., FREQ), and microscopic traffic simulation models
(e.g., Paramics). These tools vary widely in terms of key assumptions, input data, outputs
produced and computational performances. The first type of tools are simple and easy to use,
require minimal inputs, and can be carried out very quickly. However, they either do not model
peak spreading and/or route diversions, and how traffic management measures such as ramp
metering and real-time traveler information affect system performance at all, or model them in
a superficial manner. Such tools can be used as a sketch planning tool to get the first cut of the
magnitude of traffic congestion caused by a CWZ. The second type, transportation planning
tools, can model large networks and the redistribution of traffic in a network, but these tools

were designed to evaluate the long-term effect of certain changes to a network, where traffic can

75
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take time to settle-down to an “equilibrium” (or steady-state condition), which is not the case
for CWZ traffic. Naturally, this type of tools are not capable of modeling peak spreading and the
growth and decay of queues in front of the CWZ and at other places in the network. The third
type, macroscopic traffic simulation, holds promise for being an effective CWZ traffic analysis
approach, but the widely used tools in this category, like FREQ, are not capable of modeling
a general road network. Finally, the microscopic simulation tools are powerful general purpose
traffic analysis tools, and offer a wide range of features, including detailed representation of
the network, a variety of traffic management measures, dynamic traffic modeling, and usually
a powerful graphical user interface. However, these powerful features also come with a price:
microscopic simulation tools require intensive inputs, elaborative network coding, and a steep
learning curve. They are also notoriously difficult to calibrate, particularly when the network
in consideration becomes large.

Our review tells us that there still lacks an effective CWZ traffic analysis procedure that

possess the following characteristics:

1. model different geographic scopes e.g., isolated work zones, corridor, multiple CWZs in a

complicated network,

2. model diverse traffic management measures e.g., change in signal timing, traveler informa-

tion system, speed limit, lane re-stripping, etc.,

3. model travelers’ responses to capacity reduction in CWZ and to management measures
e.g., no response, divert to an alternative route, change departure time, cancel the trips,

switch to other modes, etc.,

4. produce detailed performance measures e.g., aggregate indices (e.g., total travel time,

delay, maximal queue) and disaggregate indices (e.g., delay and queuing on specific links),

5. be easy to use easy to collect input data, calibrate parameters, and set up the model,

provide reasonable results with acceptable computational overhead.

Based on our review and our own experience with different CWZ traffic analysis tools, we
took the macroscopic simulation approach to develop the tool that meets the above requirements.
In Chapter 3, we investigated travel demand shifts and studied the demand patterns before
and during construction for two rehabilitation projects: the I-710 Long Beach project and the

I-15 Devore project. Our study reveals that

1. demand diversion rate seems to be highly related to network topology, i.e., the availability

of detour routes, and the dominant travel purpose through the CWZ area.

2. the time of construction (weekend or weekday), use of traveler information system, previous
traffic condition, and capacity reduction proportion may affect diversion, but the effect is

not pronounced in these two projects.
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3. compared to demand reduction, the peak spreading effect is relatively small (I-15 project,
slight shifts; I-710 project, trivial).

It was also concluded that more data are need to draw firm conclusions.

In Chapters 4 & 5, we developed a general purpose CWZ traffic analysis software Net-
Zone. First, we proposed a systematic work zone traffic analysis procedure for quickly assessing
network-wide traffic impact of a given construction plan. This procedure includes demand prepa-
ration, dynamic traffic assignment, macroscopic traffic simulation, and scenario analysis. Then
we implemented this procedure into a software package called NetZone, which is a powerful,
versatile and user-friendly analysis tool for work zone projects that takes into account 1) de-
mand changes, 2) route diversions, 3) ramp metering, 4)arterial traffic operations, and 5)traveler
information. It provides detailed statistics on delays and queues on specific links and routes as
well as the entire network. Because it is macroscopic, it consumes much less computational and
human resources to calibrate and apply than microscopic simulations, and because it is dynamic,
it captures peak spreading and queuing. With suitable modifications, it can also be used as a
general purpose corridor study tool.

In Chapter 6, we evaluated NetZone with the SR-41 case study. The stretch of the SR-41
Fresno corridor network used in our case study contains 1365 nodes, 2090 links, 174 origins
and 168 destinations, with 7100 OD pairs, 83 signalized intersections on the arterial roads and
16 ramp meters. It is a network that took months to build and calibrate in Paramics. With
NetZone, it is coded and calibrated in weeks, and four construction/traffic management scenarios
were evaluated and the initial results were encouraging.

Although NetZone shows great promise in our preliminary evaluation study, it is never-
theless a prototype software that needs further development and refinement before it can be
widely adopted as a work zone analysis tool. Future work to improve the work zone traffic im-
pact assessment procedure and software package include the following 1) refine the CWZ traffic
model, in particular, integrate speed limit within the CWZ area; 2) continue to implement dif-
ferent types of signal control methods, eventually provide some optimal signal control strategies
based on evaluation results; 3) continue to assemble CWZ traffic data. Improve, validate and
calibrate the demand adjustment models; and 4) further test and validate the developed models

and tools.
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